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Legal information 
Warning notice system 

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent 
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert 
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are 
graded according to the degree of danger. 

 DANGER 
indicates that death or severe personal injury will result if proper precautions are not taken. 

 

 WARNING 
indicates that death or severe personal injury may result if proper precautions are not taken. 

 

 CAUTION 
indicates that minor personal injury can result if proper precautions are not taken. 

 

 NOTICE 
indicates that property damage can result if proper precautions are not taken. 

If more than one degree of danger is present, the warning notice representing the highest degree of danger will 
be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to 
property damage. 

Qualified Personnel 
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation, in particular its warning notices and safety instructions. 
Qualified personnel are those who, based on their training and experience, are capable of identifying risks and 
avoiding potential hazards when working with these products/systems. 

Proper use of Siemens products 
Note the following: 

 WARNING 
Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended 
or approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and 
maintenance are required to ensure that the products operate safely and without any problems. The permissible 
ambient conditions must be complied with. The information in the relevant documentation must be observed. 

Trademarks 
All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication 
may be trademarks whose use by third parties for their own purposes could violate the rights of the owner. 

Disclaimer of Liability 
We have reviewed the contents of this publication to ensure consistency with the hardware and software 
described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the 
information in this publication is reviewed regularly and any necessary corrections are included in subsequent 
editions. 
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 Information Server - Installation Notes 1 
1.1 Type of delivery and licenses of Information Server 

Information Server type of delivery 
Information Server 2014SP2 is provided in the following delivery units: 

● "Process Historian / Information Server 2014 SP2" DVD 

● "PCS 7 V8.2" DVD 

License types 

Client connections and licenses 

You require a license for each active client connection of the Information Server. 

The clients include: 

● The Information Server add-in for Microsoft Office Excel 

● The Information Server add-in for Microsoft Office Word 

● The Information Server add-in for Microsoft Office PowerPoint 

● Microsoft Internet Explorer, as soon as the connection to Information Server is 
established. 

Type codes for the licenses 

The SIMATIC Information Server provides the following license types: 
 
Product Version License type Validity 
Information Server 2014 Single Unlimited 
Information Server client access - Single 1 
Information Server client access - Single 3 
Information Server client access - Single 5 
Information Server client access - Single 10 
Information Server data source access - Single 1 
Information Server data source access - Single 3 
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License count for client access 
Each active client connection of the Information Server requires a license. The number of 
clients depends on the number of PCs, not on the number of applications that are open on a 
PC. Even when multiple report clients are connected to the Information Server from a PC, 
only one license is required. 

Assignment of a client license: 

● Connection with the Information Server via Internet browser/Web application 

● Connection with the Information Server via Microsoft Excel, Word oder PowerPoint 

● Use of various URLs which the server cannot identify as one source 

Release of a client license: 

● Logout from the Web application 

● Inactivity after 20 minutes 

● Closing of Microsoft Excel, Word oder PowerPoint. 

License count for data source access 
The following license conditions apply to applications:  

● You access the Process Historian database without a license. 

● You need a license to access a WinCC station. 

● You need a license to access a PCS 7 station. 

● You need a license for a redundant WinCC user station. 

● You need a license for a redundant PCS 7 user station. 

Information Server trial license 
● Setup also installs a trial license. 

● With the basic Information Server license, the Information Server includes the option of 
selecting a trial license in the license prompt. 

● The trial license is activated at the first start of the Information Server. 

● The trial license is valid for 30 days. 

● The trial version becomes a full version when you install a license. 
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1.2 System requirements 

1.2.1 Hardware requirements 

Overview 
This section specifies the hardware configuration requirements for Information Server. 

Hardware requirements 
Information Server requirements: 

● Up to 10 Information Server clients as Web application or Microsoft Office add-in 

● With infrequent to frequent reporting 

The following hardware requirements must be fulfilled for the aforementioned demands: 
 
Medium Minimum Recommended 
CPU INTEL INTEL XEON E3-1268L V3; 

2.3 GHz 
INTEL XEON E5-2650L V2; 2.6 GHz 

RAM 8 GB (64-bit operating system) 32 GB (64-bit operating system) 
Hard disks ≥ 500 GB SATA ≥ 1 TB SATA 

Process Historian and Information Server on the same system 
Process Historian and Information Server can be installed and operated on the same 
system. 

In this case the two server applications share the available hardware resources. It is 
advisable to install higher-grade equipment to be prepared for higher data request rates from 
the WinCC client systems and Information Server clients. 

 

 Note 

If Process Historian and Information Server are to be installed on the same PC, they need to 
be installed on the same SQL server instance. The Process Historian has hereby to be 
installed first. 

 

Recommendation for RAM: 

● At least 16 GB 
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WinCC and Information Server on the same system 
The following hardware requirements must be met for installation of WinCC and 
Information Server on one computer (One Station Installation): 

● Windows 7 SP1 x64 

● Intel Quad Core 

● 8 GB RAM 

 

 Note 

If WinCC and Information Server are to be installed on the same PC, they need to be 
installed on the same SQL server instance.  

WinCC has to be installed first for this purpose. 
 

This equipment is sufficient for the operation of: 

WinCC 

● Version V7.4 

● About 1000 tags can be archived per second 

● About 5 alarms can be triggered per second 

Information Server 

● Up to two Report Subscriptions with alarms can be triggered per minute 

● Up to two Report Subscriptions with tags can be triggered per minute 

(time period query about 1 to 2 hours and 1 to 2 tags per report) 

 

1.2.2 Software requirements 

1.2.2.1 Software requirements 
SIMATIC Information Server 2014 SP2 works with SIMATIC Process Historian 2014 SP2. 
Use PCS 7 V8 or WinCC V7 as the data source. 

This section contains the following information: 

● Supported Microsoft operating systems 

● Supported software components 

● Required software installations and settings 
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Operating system 

Supported operating systems 
 
Operating system Configuration Comments 
Windows 7 Professional SP1  

Enterprise SP1 
Ultimate SP1 

Standard installation 
32-bit and 64-bit 

Windows 8.1 Professional 
Enterprise 

Standard installation 
32-bit and 64-bit 

Windows 10 Professional 
Enterprise 

standard installation 
32-bit and 64-bit 

Windows Server 2008 Standard SP2 32-bit 
Windows Server 2008 R2 Standard SP1 64-bit 
Windows Server 2012 R2 Standard 64-bit 

Internet Information Server (IIS) 
Before installing the SIMATIC Information Server, you must first install the Internet 
Information Service (IIS). 

Additional information is available in the section "Installing Internet Information Services (IIS) 
(Page 12)". 

Database 
The Information Server requires the Microsoft SQL Server 2014 SP1 64-bit on the server. 
The SQL Server is automatically included in the Information Server installation. 

The corresponding access rights must be set up for accessing the SQL server data. Read 
the relevant documentation. 
 
SQL database Configuration Comments 
SQL Server 2014 SP1 32-bit and 64-bit 

Data sources 
 
Data source Version 
PCS 7 V8.0 SP1 and V8.0 SP2 

V8.1 and V8.1 SP1 
V8.2 

WinCC V7.0 SP3 Update 6 and V7.2 Update 4 
V7.3 SE including Update 1 
V7.4 
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Internet browser 
The browser you use must support HTML5. 
 
Product Version / Comments 
Internet Explorer As of version 11.0 

Make the following setting: 
1. Open the "Compatibility view settings" under "Tools". 
2. Clear the "Intranet sites in compatibility view" check box. 

Mozilla Firefox current version 
Google Chrome current version 
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Installation of Office add-ins 

Requirement 

The following components must be installed on the system to enable installation of the Office 
add-ins for Information Server: 

● Microsoft Office 

● Visual Studio Tools for Office (VSTO Runtime) 

Additional information is available in the section "Installing Visual Studio Tools for Office 
(VSTO Runtime) (Page 19)". 

Supported Office versions 

The following 32-bit Microsoft Office products are supported for the Office add-ins: 
 
Product Comments 
Microsoft Office 2007 SP3 32-bit 
Microsoft Office 2010 SP1 32-bit 
Microsoft Office 2013 32-bit 
Microsoft Office 2016 32-bit 

 
 

 Note 
Observe the following when changing the administrator password on the Information Server 

When you change the administrator password, you must carry out the following additional 
settings: 
1. You also have to change the passwords in the "Information Server Datahost Service" and 

"Information Server Scheduler" in the "Log on" properties/tab. 
2. In the IIS Manager, you have to open the dialog "Advanced settings" via the context 

menu in the "InfSrvPool" application pool and proceed as follows: 
– Select "Identity" and click the button to browse in this line. 
– Enter the new user with the new password. 
– Click "OK" in all the windows. 

3. Restart the computer. 
 

See also 
System requirements (Page 7) 

Installing the Information Server (Page 22) 

Installing Internet Information Services (IIS) (Page 12) 

Installing Visual Studio Tools for Office (VSTO Runtime) (Page 19) 
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1.2.2.2 Installing Internet Information Services (IIS) 
This section describes the installation of Internet Information Services (IIS) for the approved 
operating systems. 

You do not need a data medium or download for the installation of the Internet 
Information Services (IIS). 

 

See also 
Software requirements (Page 8) 
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Installing IIS for Windows 7 SP1 
This section describes installation of the Internet Information Services (IIS) in Windows 7 
SP1. 

Requirement 
● You are logged on as administrator. 

Procedure 
1. Select "Start > Control Panel > Programs > Programs and Features". 

2. Click the "Turn Windows features on or off" link in the dialog. 

3. Open the "Windows Features" dialog. 

4. Open the "Internet Information Services" in the explorer view of the "Windows Features" 
dialog. 

5. Specify the required settings for the "Internet Information Services". 

Under "Application Development Features", select: 

– ASP.NET 

– .NET Extensibility 

– ISAPI Extensions 

– ISAPI Filters 

Select the following in the next "Common HTTP Features" section: 

– Static Content 

– Directory Browsing 

In the "Security" section, select: 

– Basic Authentication 

– Windows Authentication 

Select the following under "Web Management Tools": 

– IIS Management Console 

6. Install the "Internet Information Services (IIS)" with the settings you have made. 

Result 
The required settings are complete and the Internet Information Services (IIS) are installed 
on Windows 7 SP1. 

Installing IIS for Windows 8.1 
This section describes installation of the Internet Information Services (IIS) on Windows 8.1 . 
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Requirement 
● You are logged on as administrator. 

Procedure 
1. Select "Charms > Settings > Control Panel > Programs and Features". 

2. Click the "Turn Windows features on or off" link in the dialog. 
The "Windows Features" dialog opens. 

3. Open the "Internet Information Services" in the explorer view of the "Windows Features" 
dialog. 

4. Specify the required settings for the "Internet Information Services". 

5. Under "Application Development Features", select: 

– ASP.NET 4.5 

– .NET Extensibility 

– ISAPI Extensions 

– ISAPI Filters 

Verify or select the following settings in the "Common HTTP Features" section: 

– HTTP Errors 

– Default Document 

– Static Content 

– Directory Browsing 

In the "Security" section, select: 

– Basic Authentication 

– Windows Authentication 

Select the following under "Web Management Tools": 

– IIS Management Console 

6. Install the "Internet Information Services (IIS)" with the settings you have made. 

Result 
The required settings are complete. The Internet Information Services (IIS) are installed on 
Windows 8.1. 

Installing IIS for Windows Server 2008 SP2 
This section describes the installation of the Internet Information Services (IIS) on a 
Windows Server 2008 SP2. 
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Requirement 
● You are logged on as administrator. 

Procedure 
1. Configure the settings in Server Manager using the "Add Role" wizard. 

Configure the "Web Server (IIS)" role as follows: 

2. Select "Start > Control Panel > Programs and Features" to open Server Manager. 

3. Select "Roles" in the explorer of Server Manager. 

4. Select "Add Roles" in the 'Roles Summary'. 

5. Select the "Web Server (IIS)" option in the "Select Server Roles" dialog. 

6. Specify the settings in "Web Server (IIS) > Role Services". 

Under "Web Server > Application Development", enable: 

– ASP.NET 

– .NET Extensibility 

– ISAPI Extensions 

– ISAPI Filters 

Under "Web Server > General HTTP Features", enable: 

– Static Content 

– Directory Browsing 

Select "Web Server > Security" and select: 

– Basic Authentication 

– Windows Authentication 

Select "Web Server > Management Programs" and select: 

– IIS Management Console 

7. Install the "Web Server (IIS)" server role based on your settings. 

Result 
The required settings are complete and the Internet Information Services (IIS) are installed 
on Windows Server 2008 SP2. 
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Installing IIS for Windows Server 2008 R2 SP1 
This section describes the installation of Internet Information Services (IIS) on Windows 
Server 2008 R2 SP1. 

Requirement 
● You are logged on as administrator. 

Procedure 
1. Configure the settings in Server Manager using the "Add Role" wizard. 

Configure the "Web Server (IIS)" role as follows: 

2. Select Start > Programs > Administration > Server Manager to open Server Manager. 

3. Select "Roles" in the explorer of Server Manager. 

4. Right-click to open the shortcut menu and select 'Select Role Services'. 

5. Select the "Web Server (IIS)" option in the "Select Role Services" dialog. 

6. Specify the settings in "Web Server (IIS) > Role Services". 

Select "Web Server > Application Development" and select: 

– ASP.NET 

– .NET Extensibility 

– ISAPI Extensions 

– ISAPI Filters 

Select "Web Server > General HTTP Features" and select 

– Static Content 

Select "Web Server > Security" and select: 

– Basic Authentication 

– Windows Authentication 

Select "Web Server > Management Programs" and select: 

– IIS Management Console 

7. Install the "Web Server (IIS)" server role based on your settings. 

Result 
The required settings are complete and the Internet Information Services (IIS) are installed 
on Windows Server 2008 R2 SP1. 
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Installing IIS for Windows Server 2012 R2 
This section describes the installation of the Internet Information Services (IIS) on a 
Windows Server 2012 R2. 

Requirement 
● You are logged on as administrator. 

Procedure 
1. Configure the settings in Server Manager using the "Adding roles and features wizard". 

Configure the "Web server (IIS)" role with the installation wizard as follows: 

2. Activate the "Role-based or feature-based installation" option in the "Select installation 
type" dialog. 

3. Activate the "Select server from server pool" option under '"Select target server". 

4. Under "Roles", activate the "Web server (IIS)" role in the next menu, "Server roles". 

The "Adding roles and features wizard" dialog opens. 

5. Activate "Include management tools (if available)". 

The selection window opens. 

6. Confirm the action with "Add Features". 

7. Back in the configuration wizard, select the "Features" submenu. 

8. Select ".NET Framework 4.5 functions". 

9. Select "ASP.NET 4.5". 
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10. Specify the required settings for the "Internet Information Services". 

Under "Application Development Features", select: 

– ASP.NET 4.5 

– .NET Extensibility 4.5 

– ISAPI Extensions 

– ISAPI Filters 

 Verify or select the following settings in the "Common HTTP Features" section: 

– HTTP Errors 

– Default Document 

– Static Content 

– Directory Browsing 

In the "Security" section, select: 

– Basic Authentication 

– Windows Authentication 

Select the following under "Web Management Services": 

– IIS Management Console 

11. Click "Next" to go to the "Confirm installation selections" submenu. 

12. Check your configuration settings. 

13. In the installation wizard, complete the configuration by clicking "Install". 

Result 
The required settings are complete. The Internet Information Services (IIS) are installed on 
Windows Server 2012 R2. 



 Information Server - Installation Notes 
 1.2 System requirements 

SIMATIC Information Server 
System Manual, 05/2017, A5E38560846-AB 19 

1.2.2.3 Installing Visual Studio Tools for Office (VSTO Runtime) 

Requirement 
● You are logged on as administrator. 

Requirements for installation of the Office add-ins 
The following components must be installed on the system to enable installation of the 
Office add-ins for Information Server: 

● Visual Studio Tools for Office (VSTO Runtime) 

● Microsoft.NET Framework 4.5.1 

Visual Studio Tools for Office (VSTO Runtime) is generally installed using the setup of the 
WinCC or PCS 7 DVD. 

● Installing Information Server Office Add-Ins (Page 28) 

For direct installation via the Information Server website, you can download the 
Visual Studio Tools for Office (VSTO Runtime) from the following link:  

● http://www.microsoft.com/en-us/download/ (http://www.microsoft.com/en-us/download/) 

(Search input: Visual Studio Tools Office)  

Note the information from Microsoft regarding system requirements. If you want to install a 
different language, refer to the information from Microsoft for details. 

You can download Microsoft.NET Framework 4.5.1 from the following link: 

● http://www.microsoft.com/en-us/download/details.aspx?id=40779 
(http://www.microsoft.com/en-us/download/details.aspx?id=30653) 

Installing Visual Studio Tools for Office (VSTO Runtime)  
1. Download the suitable VSTO version for the installed Office version. 

2. Run the software setup. 

3. Follow the instructions of the installation wizard. 

Result 
The 'Visual Studio Tools for Office' are installed. 

See also 
Microsoft.NET Framework 4.5.1 Download (http://www.microsoft.com/en-
us/download/details.aspx?id=40779) 

http://www.microsoft.com/en-us/download/
http://www.microsoft.com/en-us/download/details.aspx?id=30653
http://www.microsoft.com/en-us/download/details.aspx?id=40779
http://www.microsoft.com/en-us/download/details.aspx?id=40779
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1.2.3 Security settings 

Introduction 

This section describes the configuration of the security settings for Information Server. 

Always take the following into account: 

● The security settings of the firewall are the basis of the security concept. 

● Additional Windows services, such as IS-Ready or CCCAPHServer, must be configured 
via the operating system with user rights. 

● Use complex passwords. 

● Set an access barrier if several logon attempts are unsuccessful. You can find additional 
information under "https://technet.microsoft.com/en-
us/library/cc757692(v=ws.10).aspx?f=255&MSPPError=-2147217396 
(https://technet.microsoft.com/en-
us/library/cc757692(v=ws.10).aspx?f=255&MSPPError=-2147217396)": 

● If required, rename the Administrator account. 

User permission for the Information Server service 
The Information Server Ready (IS-Ready) component is configured with the "Service 
Configuration Wizard". 

The description for user permission can be found in the section "Installing the Information 
Server Ready component (Page 25)". 

Adapting the security settings of the browser 
Adapt the security settings in the browser. The procedure described in the example is for the 
Internet Explorer: 

1. Open the settings for the "Internet options". 

2. Open the "Security" tab. 

3. Deactivate the "Protected mode" setting for the current zone. 

4. Select the zone "Local intranet" or "Trusted sites". Click "Sites". 

Add the following links to the sites: 

– http://<PC name> 

– about:blank 

5. Deactivate the "Require server verification (https) for all sites in this zone" option. 

6. In the Security tab, click "Custom level". Under "User authentication", select the option 
"Prompt for user name and password". 

 
  Note 

For the initial commissioning, the "Automatic logon with current user name and password" 
setting is required. 

 

https://technet.microsoft.com/en-us/library/cc757692(v=ws.10).aspx?f=255&MSPPError=-2147217396
https://technet.microsoft.com/en-us/library/cc757692(v=ws.10).aspx?f=255&MSPPError=-2147217396
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Firewall security settings 

Settings of the internal firewall for the Information Server 
 
Name Logs Port 
IS Network Discovery UDP 137 
IS Web Access http TCP 80 
IS Web Access https TCP 443 
IS Data Host TCP 65125 
IS DiscoverServiceInstaller UDP 5049 
IS Ready update Plugin TCP 1200 
Scheduler TCP 64721 

 

 

 Note 

The firewall ports that are opened through the installation of Information Server and IS-
Ready must be manually removed after an uninstall. 

 

Notes for communication on the Internet  

Communication: Connection via HTTPS 

To increase the security of your communication, configure the server in such a way that only 
HTTPS connections are supported.  

You need a digital certificate for the Information Server. For more information, refer to "How 
to Set Up an HTTPS Service in IIS" (http://support.microsoft.com/kb/324069 
(http://support.microsoft.com/kb/324069)) in Microsoft Support.  

Make sure that the database and application servers communicate in a shared area to 
exchange confidential data, a so-called demilitarized zone (DMZ). 

If the database server and the application server are located in separate areas, use 
appropriate measures to ensure confidential communication (authentication and encryption). 
For example, use a Virtual Private Network tunnel (VPN). 

Avoid cross-site request forgery for the web server (Cross-Site Request Forgery). 

The cross-site request forgery is similar to the weak point caused by cross-site scripting 
(XSS, Cross Site Scripting). The attack is triggered when an authenticated user clicks on a 
malicious link. This weak spot exists even if scripting is deactivated in the browser. 

Siemens recommends: 

● Do not work with other applications or services that have anything to do with the Internet. 

● Log off when you do not need the web server any longer. 

You can find additional information in the Microsoft MSDN Portal under "IIS Security": 

● http://msdn.microsoft.com/de-de/library/ms172965%28v=sql.105%29.aspx 
(http://msdn.microsoft.com/en-us/library/ms172965%28v=sql.105%29.aspx) 

http://support.microsoft.com/kb/324069
http://msdn.microsoft.com/en-us/library/ms172965%28v=sql.105%29.aspx
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Defense in depth 
See the notes on "Industrial Security" on the Siemens website: 

● http://www.industry.siemens.com/topics/global/en/industrial-
security/concept/Pages/defense-in-depth.aspx 
(http://www.industry.siemens.com/topics/global/en/industrial-
security/concept/Pages/defense-in-depth.aspx) 

See also 
http://www.industry.siemens.com/topics/global/en/industrial-security/concept/Pages/defense-
in-depth.aspx (http://www.industry.siemens.com/topics/global/en/industrial-
security/concept/Pages/defense-in-depth.aspx) 

http://support.microsoft.com/kb/324069 (http://support.microsoft.com/kb/324069) 

http://msdn.microsoft.com/de-de/library/ms172965%28v=sql.105%29.aspx 
(http://msdn.microsoft.com/en-us/library/ms172965%28v=sql.105%29.aspx) 

https://technet.microsoft.com/en-us/library/cc757692(v=ws.10).aspx?f=255&MSPPError=-
2147217396 (https://technet.microsoft.com/en-
us/library/cc757692(v=ws.10).aspx?f=255&MSPPError=-2147217396) 

1.3 New installation / Initial installation 

1.3.1 Installing the Information Server 
Use one of these DVDs for installation: 

● DVD "Process Historian / Information Server 2014 SP2" 

● DVD "PCS 7 V8.2" 

Server installation 
To administer the Information Server, install the "Information Server 2014 SP2". 

You use this computer to create and manage the configured reports and dashboards. 

Configuration manager 
The configuration manager is launched automatically at the first restart after installation of 
the Information Server. The configuration manager makes all required settings for operating 
the Information Server. 

In the configuration manager, you specify how the Information Server is launched. You can 
specify to call Information Server as new website or as virtual directory. 

After the configuration, you must restart the computer using the configuration manager. 

http://www.industry.siemens.com/topics/global/en/industrial-security/concept/Pages/defense-in-depth.aspx
http://www.industry.siemens.com/topics/global/en/industrial-security/concept/Pages/defense-in-depth.aspx
http://www.industry.siemens.com/topics/global/en/industrial-security/concept/Pages/defense-in-depth.aspx
http://www.industry.siemens.com/topics/global/en/industrial-security/concept/Pages/defense-in-depth.aspx
http://support.microsoft.com/kb/324069
http://msdn.microsoft.com/en-us/library/ms172965%28v=sql.105%29.aspx
https://technet.microsoft.com/en-us/library/cc757692(v=ws.10).aspx?f=255&MSPPError=-2147217396
https://technet.microsoft.com/en-us/library/cc757692(v=ws.10).aspx?f=255&MSPPError=-2147217396
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Installation of Information Server Ready 
The WinCC stations and the PCS 7 Operator Stations (OS) need the "Information Server 
Ready" (IS-Ready) component for communication with the Information Server. 

IS-Ready is always installed as option when you install Process Historian, PCS 7 or WinCC 
V7. In this case, the IS-Ready component is also selected in the setup and cannot be 
deselected. 

However, if you are using a PC with a WinCC version prior to WinCC V7.2, you must install 
IS-Ready later. Additional information is available in the section "Installing the Information 
Server Ready component (Page 25)". 

Installation of the Information Server Office add-ins 
If you want to use the reporting in MS Excel, MS Word or MS PowerPoint, the Information 
Server Office add-ins must be installed on the PC. Select this component during installation.  

If you want to use Office add-ins on a PC without an Information Server installation, follow 
the instructions in the section "Installing Information Server Office Add-Ins (Page 28)". 

Installing Information Server BATCH Options 
If you are using the Information Server BATCH Options for PCS 7 for SIMATIC BATCH 
reporting, you must also install the BATCH Options. 

Follow the instructions in the section "Installing Information Server BATCH Options at a later 
time (Page 29)". 

Information Server and Process Historian on the same computer 
Use the program package "Process Historian and Information Server 2014 SP2" if you have 
installed and want to operate Information Server and Process Historian on the same 
computer. 

Requirement 
● An HTML5-compliant Internet browser is installed, for example, Internet Explorer 11. 

● The Internet Information Service (IIS) is installed. 
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Procedure: Installing the Information Server 
1. Run the setup. 

2. Follow the instructions of the installation wizard. 

Read the License Agreement and the Open Source License Agreement. 

3. If necessary, enter the following information in the "User information" dialog: 

– User 

– Associated organization 

4. Depending on which DVD you used, select the following "Type of installation": 

– Process Historian / Information Server 2014 SP2: No selection required. 

– PCS 7 V8.2: "Package installation" or "Custom installation". 

5. Select the component you wish to install in the "Program packages" dialog: 

– Process Historian / Information Server 2014 SP2: 

Category "Information Server": Information Server 2014 SP2 

– PCS 7 V8.2: 

Category "Runtime > Archiving and Reporting": Information Server 2014 SP2 

6. If required, select additional components: 

– Information Server Office Addin 2014 SP2 

– Information Server - BATCH Options 2014 SP2 

(Reporting for SIMATIC Batch) 

7. If necessary, confirm the changes to the system settings in the "System settings" dialog. 

8. Start installation. 

9. To complete the installation, reboot the system. 

You can also perform the restart at a later time. 

10. Run the configuration manager that opens after the restart. 

11. Enter the user name and the password for the DataHost scheduler. Use the user name 
and the password of the administrator who installed the Information Server. 

12. In the "IIS configuration" step, select the "Create a new website" option and then select 
the port "80". 

13. Restart the computer. 

Result 
● The Information Server is installed. 

● The Web page for the Information Server was created. 
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See also 
Software requirements (Page 8) 

Installing Information Server Office Add-Ins (Page 28) 

Installing the Information Server Ready component (Page 25) 

Installing Information Server BATCH Options at a later time (Page 29) 

1.3.2 Installing the Information Server Ready component 
The WinCC stations and the PCS 7 Operator Stations (OS) need the "Information Server 
Ready" (IS-Ready) component for communication with the Information Server. 

IS-Ready is always installed as an option when you install one of the following products: 

● Process Historian 

● PCS 7 V8 

● WinCC V7 

Requirement 
For using IS-Ready with WinCC: 

● The user must be part of the SIMATIC HMI user group. 

● The PC on which Is Ready is installed requires at least 8 GB RAM. 

For using IS-Ready with Process Historian: 

● The user must be created as system administrator on the SQL Server instance. 

The following applies to the use of IS-Ready both with WinCC and Process Historian: 

● The user must have the rights to create a database. 

 
  Note 

The Microsoft SQL Server 2008 R2 database was supported up to the version 
Information Server 2014 SP1. The Microsoft SQL Server 2014 SP1 database is 
supported as of version Information Server 2014 SP2. 
A user who was defined as local administrator under the database version 2008 R2 
automatically has the right to create a database.  
With database version 2014 SP1, you have to additionally assign the right to the user. 
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Procedure 
1. Run the setup. 

2. Follow the instructions of the installation wizard. 

Read the License Agreement and the Open Source License Agreement. 

3. Select the component you wish to install in the "Program packages" dialog: 

– Category "Information Server": Information Server 2014 SP2 

4. Start installation. 

5. To complete the installation, reboot the system. 

You can also perform the restart at a later time. 

6. Configure the IS-Ready service with the service configuration wizard. 
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Configuring IS-Ready service 
Once the PC has been restarted, start the configuration wizard.  

You use the service configuration wizard to specify the user under which the IS-Ready 
service is run. The user should be the same user who installed the Information Server. 

The user of the IS-Ready service is automatically a member of the "SIMATIC HMI" user 
group. 

 

 Note 
Using IS-Ready with WinCC 

Create a group with the name SIMATIC Report Services and add the IS Ready service user 
to the group. 

 

Procedure 

1. Start the configuration wizard from the "Siemens Automation" program group: 

SIMATIC > IS-Ready > IS-Ready Configuration 

2. Select the "Run with user credentials" option in the "New security setting" area. 

3. Enter the user under which the Information Server was installed. Enter the password. 

The user must have been created on the OS. 

4. Complete the configuration with "Finish". 

You can run the configuration wizard at any time to modify the access rights. 
 

 Note 
The specified passwords must be identical on the computers. 

Make sure that all specified passwords are identical on the following systems: 
• WinCC OS/PCS 7 OS 
• PH server 

Make sure to notice any changes to passwords. 
 

Result 
The Information Server Ready component is installed on the PC. 

See also 
Installing the Information Server (Page 22) 
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1.3.3 Installing Information Server Office Add-Ins 
To use the Office add-ins of MS Excel, MS Word or MS PowerPoint for reporting, these add-
ins must be installed on the PC.  

You can install the Office add-ins with the Information Server. Additional information is 
available in the section "Installing the Information Server (Page 22)". 

If you want to use Office add-ins on a PC without an Information Server installation, follow 
these instructions. 

Requirement 
● Microsoft .NET Framework 4.5.1 is installed. 

Procedure 
1. Open the Information Server Web application. 

2. Select "Download Office add-ins" on the start page to load the Office add-ins. 

3. Follow the instructions of the installation wizard. 

4. Wait for the Windows installer to initialize the "SIMATIC Information Server add-in setup". 

5. Select the elements you want to install under 'Information Server add-in'. 

Installation of the Office add-ins demands a certain amount of free space on your HDD. 
The required space and location is displayed in the 'Programs' setup dialog. 

– Click "Storage space" if you want to query the storage space that is available on your 
system. 

– Click "Help" if you need additional support. 

6. Check the summary of the components to install in the next dialog view. 

Click "Back" and follow the instructions of the wizard if you want to revise the previously 
selected settings. 

7. Start installation. 

Result 
The Office add-ins are installed for the Information Server. 

See also 
Installing the Information Server (Page 22) 
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1.3.4 Installing Information Server BATCH Options at a later time 
If you are using the Information Server BATCH Options for PCS 7 for SIMATIC BATCH 
reporting, you must also install the BATCH Options. 

Follow the steps below: 

1. Install Information Server or run the upgrade installation. 

2. Install Information Server BATCH Options. 

Requirement 
● The latest version of the Information Server is installed on the PC. 

Procedure 
1. Start the setup from the PCS 7 DVD. 

2. Follow the instructions of the installation wizard. 

Read the License Agreement and the Open Source License Agreement. 

3. Select the "Custom installation" type of installation. 

4. In the category "Archiving and Reporting", select the required component 
"Information Server - BATCH Options". 

5. To complete the installation, reboot the system. 

Result 
The "Information Server BATCH Options" component is installed or updated. 

See also 
Installing the Information Server (Page 22) 

Upgrading Information Server (Page 31) 



Information Server - Installation Notes  
1.4 Information Server Upgrade Installation 

 SIMATIC Information Server 
30 System Manual, 05/2017, A5E38560846-AB 

1.4 Information Server Upgrade Installation 

1.4.1 Overview of the upgrade installation 
You can upgrade a previous version of the Information Server to the current version using 
the upgrade installation. 

Procedure of the upgrade installation 
To upgrade the Information Server , follow the instructions in the Installation Notes of the 
Information Server 2014 SP2.  

Depending on the installed version, the upgrade installation may need to take place via 
intermediate versions, as shown in the following table: 

 
From version Via version Via version Via version To version 
V8.0 2013 Update 6 2014 SP1 Update 1 2014 SP2 2014 SP2 Update 3 
V8.0 Update 1 2013 Update 6 2014 SP1 Update 1 2014 SP2 2014 SP2 Update 3 
2013 2013 Update 6 2014 SP1 Update 1 2014 SP2 2014 SP2 Update 3 
2013 Update 1 2013 Update 6 2014 SP1 Update 1 2014 SP2 2014 SP2 Update 3 
2013 Update 2 2013 Update 6 2014 SP1 Update 1 2014 SP2 2014 SP2 Update 3 
2013 Update 3 2013 Update 6 2014 SP1 Update 1 2014 SP2 2014 SP2 Update 3 
2013 Update 4 2013 Update 6 2014 SP1 Update 1 2014 SP2 2014 SP2 Update 3 
2013 Update 5 2013 Update 6 2014 SP1 Update 1 2014 SP2 2014 SP2 Update 3 
2013 Update 6 - 2014 SP1 Update 1 2014 SP2 2014 SP2 Update 3 
2013 Update 7 - 2014 SP1 Update 1 2014 SP2 2014 SP2 Update 3 
2014 - - 2014 SP2 2014 SP2 Update 3 
2014 Update 1 - - 2014 SP2 2014 SP2 Update 3 
2014 SP1 - - 2014 SP2 2014 SP2 Update 3 
2014 SP1 Update 1 - - 2014 SP2 2014 SP2 Update 3 
2014 SP2 - - - 2014 SP2 Update 3 
2014 SP2 Update 1 - - - 2014 SP2 Update 3 
2014 SP2 Update 2 - - - 2014 SP2 Update 3 

See also 
Upgrading Information Server (Page 31) 
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1.4.2 Upgrading Information Server 
You can upgrade a previous version of the Information Server to the latest version with the 
upgrade installation. 

Procedure 
1. Close all active processes of the predecessor version of Information Server and shut 

down the application. 

2. Run the setup. 

3. Follow the instructions of the installation wizard. 

Read the License Agreement and the Open Source License Agreement. 

4. Follow the instructions of the installation wizard. 

5. Select "Update" as the setup type. 

The "Update software" dialog shows the components which are updated. 

6. Start installation. 

7. To complete the installation, reboot the system. 

You can also perform the restart at a later time. 

8. Run the configuration manager that opens after the restart. 

Result 
The Information Server is updated. 

1.4.3 Upgrading Information Server Ready 
After the upgrade installation of the Information Server server, upgrade the other PCs of the 
system: 

● On the WinCC stations 

● On the PCS 7 operator stations (OS) 

Install the Information Server Ready (IS-Ready) and configure the IS-Ready service. 

When you upgrade the PC, the Information Server Ready (IS-Ready) component is 
automatically installed at the same time. 
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Installing the Information Server Ready 
1. Remove the previous version of IS-Ready. 

2. Restart the computer. 

3. To start the Information Server Ready Setup, follow these steps: 

– For PCS 7:  
On the PCS 7 DVD 2, start the Setup via: 
"27_InformationServer__V8.2\ISReady\setup\setup.exe". 

– For WinCC: 

"Process Historian / Information Server" DVD 
Run the setup. 

4. Follow the instructions of the installation wizard. 

Read the License Agreement and the Open Source License Agreement. 

5. To complete the installation, reboot the system. 

6. Configure the IS-Ready service with the service configuration wizard. 
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Configuring IS-Ready service 
Once the PC has been restarted, start the configuration wizard.  

You use the service configuration wizard to specify the user under which the IS-Ready 
service is run. The user should be the same user who installed the Information Server. 

The user is automatically a member of the "SIMATIC HMI" user group. 

Procedure 

1. Start the configuration wizard from the "Siemens Automation" program group: 

SIMATIC > IS-Ready > IS-Ready Configuration 

2. Select the "Run with user credentials" option in the "New security setting" area. 

3. Enter the user under which the Information Server was installed. Enter the password. 

The user must have been created on the OS. 

4. Complete the configuration with "Finish". 

You can run the configuration wizard at any time to modify the access rights. 
 

 Note 
The specified passwords must be identical on the computers for a user. 

Make sure that all passwords specified for a user are identical on the following systems: 
• WinCC OS/PCS 7 OS 
• PH server 
• Witness server 

Make sure to notice any changes to passwords. 
 

Result 
The Information Server Ready component is installed on the computer. 
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1.4.4 Upgrading Information Server Batch Options 

Introduction 
If you are using the Information Server BATCH Options for PCS 7 for SIMATIC BATCH 
reporting, you must also install the BATCH Options. 

Follow the steps below: 

1. Install Information Server or run the upgrade installation. 

2. If you upgrade from Information Server 2013 to Information Server 2014 SP2 , you need 
to re-install the installed Information Server BATCH Options from Information Server 2013 
. 

3. Install Information Server BATCH Options. 

Requirement 
● The latest version of the Information Server is installed on the PC. 

Procedure 
1. Start the setup from the PCS 7 DVD. 

2. Follow the instructions of the installation wizard. 

Read the License Agreement and the Open Source License Agreement. 

3. Select the "Custom installation" type of installation. 

4. In the category "Archiving and Reporting", select the required component 
"Information Server - BATCH Options". 

5. To complete the installation, reboot the system. 
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Procedure when upgrading from Information Server 2013 to Information Server 2014 SP2 
1. Insert your PCS 7 DVD2. 

2. Open the "Additional_Products" folder and re-install the installed Information Server 
BATCH Options . 

3. To complete the installation, reboot the system. 

4. Configure the Information Server: 

– Start Internet Explorer 11 as administrator. Enter "http://localhost" as the URL. 

– Select the report server instance and start the configuration. 

5. When the configuration is complete, start the setup from the PCS 7 DVD. 

6. Follow the instructions of the installation wizard. 

Read the License Agreement and the Open Source License Agreement. 

7. Select the "Custom installation" type of installation. 

8. In the category "Archiving and Reporting", select the required component 
"Information Server - BATCH Options". 

9. To complete the installation, reboot the system. 

Result 
The "Information Server BATCH Options" component is installed or updated. 
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 Information Server - Release Notes 2 
2.1 Release Notes 

Content 
These release notes contain important information for the SIMATIC Information Server. 

The statements in these Release Notes are more binding than the instructions in the 
manuals and in the online help. 

Read these release notes carefully as they contain useful information. 

LogViewer 
With version 2014 SP2, a tool which is not supported is installed to analyze log files from 
Process Historian and Information Server. 

This tool should only be used by appropriately trained personnel (support, hotline...). During 
the analysis of many or very large log files, the tool consumes a large amount of work 
memory, which can impair the mode of operation of the system. 

"IIS Configuration": Change focus to dialog  
There may be some rare cases in which the "IIS Configuration" dialog is covered up by the 
"SIMATIC Information Server Setup" when installing the Information Server and 
Process Historian. 

Change the focus to the "IIS Configuration" dialog to make a manual input. 

Memory: Expansion  
If the main memory is not sufficient for creating a report, the maximum limit of the reporting 
services will not automatically be recalculated. 

In this case start the Configuration Manager of the Information Server manually.  

For 32 Bit operating systems, it can be found under: 

● C:\Program 

Files\Siemens\InformationServer\ConfigurationManager\ConfigurationManager.exe 

For 64 Bit operating systems, it can be found under: 

● C:\Program 

Files(x86)\Siemens\InformationServer\ConfigurationManager\ConfigurationManager.exe 

The limit of the main memory is readjusted. 
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Unexpected response in the Office add-in 
If the Office add-in exhibits an unexpected response, a dialog opens which prompts you to 
disable the Office add-in. 

1. Confirm the dialog with "YES". 

To re-activate the Office add-in, proceed as follows: 

1. Open the Office application. 

2. Select the "File" tab. 

3. Click the "Options" button. 

4. Navigate to "Add-ins" in the "Categories" area. 

5. Navigate to "Disabled Items" in the "Manage" field. 

6. Click "Go...". 

7. Select the Information Server Office add-in and click "Enable". 

8. Click "Close". 

9. Restart the Office application. 

You can find additional information under: Enable the add-in (https://msdn.microsoft.com/en-
us/library/ms268871.aspx) 

See also 
http://support.automation.siemens.com/WW/view/en/67502173 
(http://support.automation.siemens.com/WW/view/en/67502173) 

https://msdn.microsoft.com/en-us/library/ms268871.aspx
https://msdn.microsoft.com/en-us/library/ms268871.aspx
http://support.automation.siemens.com/WW/view/en/67502173
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2.2 Service and Support 

2.2.1 Warnings 

Safety information 

Warning notice system 

This manual contains notices you must observe to ensure your personal safety and to 
prevent damage to property. Notices referring to your personal safety are highlighted in the 
manual by a safety alert symbol; notices referring to property damage only have no safety 
alert symbol. The warning notices shown below are graded according to the degree of 
danger. 

 

 DANGER 

indicates that death or severe personal injury will result if proper precautions are not taken. 
 

 WARNING 

indicates that death or severe personal injury may result if proper precautions are not 
taken. 

 

 CAUTION 

indicates that minor personal injury may result if proper precautions are not taken. 
 

 NOTICE 

indicates that property damage may result if proper precautions are not taken. 
 

 Note 

indicates important information about the product and its use or a specific section of the 
documentation to which you should pay particular attention. 

 

If more than one degree of danger is present, the warning notice representing the highest 
degree of danger will be used. A warning notice of injury to persons with a safety alert 
symbol may also include a warning relating to property damage. 

Qualified personnel 
The product/system described in this documentation may be operated only by personnel 
qualified for the specific task in accordance with the relevant documentation, in particular its 
warning notices and safety information. Qualified personnel are those who, based on their 
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training and experience, are capable of identifying risks and avoiding potential hazards when 
working with these products/systems. 

Proper use 

Note the following: 
 

 WARNING 

Proper use of Siemens products 

Siemens products may only be used for the applications described in the catalog and in the 
relevant technical documentation. If products and components from other manufacturers 
are used, these must be recommended or approved by Siemens. Proper transport, storage, 
installation, assembly, commissioning, operation and maintenance are required to ensure 
that the products operate safely and without any problems. The permissible ambient 
conditions must be adhered to. The information in the relevant documentation must be 
observed. 

 

Trademarks 
All names identified by ® are registered trademarks of Siemens AG. The remaining names in 
this publication may be trademarks whose use by third parties for their own purposes could 
violate the rights of the owner. 

Security information 
Siemens provides products and solutions with industrial security functions that support the 
secure operation of plants, systems, machines and networks. 

In order to protect plants, systems, machines and networks against cyber threats, it is 
necessary to implement – and continuously maintain – a holistic, state-of-the-art industrial 
security concept. Siemens’ products and solutions only form one element of such a concept. 

Customers are responsible for preventing unauthorized access to their plants, systems, 
machines and networks. Systems, machines and components should only be connected to 
the enterprise network or the Internet if necessary and only to the extent necessary and with 
appropriate protective measures (e.g. use of firewalls and network segmentation) in place.  

Additionally, Siemens’ guidance on appropriate security measures should be taken into 
account. For more information about industrial security, please visit 

● http://www.siemens.com/industrialsecurity (http://www.siemens.com/industrialsecurity) 

Siemens’ products and solutions undergo continuous development to make them more 
secure. Siemens strongly recommends applying product updates as soon as they are 
available and always using the latest product versions. Using versions that are obsolete or 
are no longer supported can increase the risk of cyber threats.  

To stay informed about product updates, subscribe to the Siemens Industrial Security RSS 
Feed under  

● http://www.siemens.com/industrialsecurity (http://www.siemens.com/industrialsecurity) 

http://www.siemens.com/industrialsecurity
http://www.siemens.com/industrialsecurity
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Disclaimer of liability 
We have reviewed the contents of this publication to ensure consistency with the hardware 
and software described. However, since variance cannot be precluded entirely, we cannot 
guarantee full consistency. However, the information in this publication is reviewed regularly 
and any necessary corrections are included in subsequent editions. Suggestions for 
improvement are welcomed. 

Information in the online documentation is more binding than that in the manuals and PDF 
files. 

Observe the Release Notes and Installation Notes. Information in the Release Notes and 
Installation Notes is more binding than that in the manuals and online help. 

Copyright © Siemens AG 2017 
All rights reserved 

The reproduction, transmission or use of this document or its contents is not permitted 
without express written authorization. Offenders will be held liable for payment of damages. 
All rights, including rights created by patent grant or registration of a utility or design, are 
reserved. 

Siemens AG 

Division Digital Factory 

SIMATIC Human Machine Interfaces 

P.O. Box 4848 

D-90026 Nuremberg, Germany 

 

See also 
http://www.siemens.com/industrialsecurity (http://www.siemens.com/industrialsecurity) 

http://www.siemens.com/industrialsecurity
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2.2.2 Customer Support 

Customer Support and Technical Support  
You can reach the SIMATIC hotlines at the times specified in the following table. The 
SIMATIC hotline employees speak German and English. The Authorization hotline offers 
French, Italian or Spanish customer support in addition to German and English. 

Technical support 
 
Nuremberg (GMT +1:00) 
Service 
Hours 

Monday - Friday, 8:00 to 17:00 (CET/CEST) 

Phone +49 (0)911 895 7222 
Fax +49 (0)911 895 7223 
E-mail http://www.siemens.com/automation/support-request 

(http://www.siemens.com/automation/support-request)  

An overview of the Technical Support is available at the following URL: 

● http://support.automation.siemens.com/WW/view/en/16605032 
(http://support.automation.siemens.com/WW/view/en/16605032) 

Automation Value Card (AVC) 

The Automation Value Card (AVC) provides extended Technical Support and is available 24 
hours every day of the week. Information on the AVC can be found at the following URL: 

● http://support.automation.siemens.com/WW/view/en/21981898 
(http://support.automation.siemens.com/WW/view/en/21981898) 

SIMATIC Customer Online Support  

Service and Support  

An overview of the support offering for our products is available at the following URL: 

● http://www.siemens.com/automation/service&support 
(http://www.siemens.com/automation/service&support) 

In Product Support, for example, you will find downloads of firmware updates, service packs 
and useful utilities. 

Online Help is available so that you can successfully use the Support offering. Open the 
Online Help by selecting the corresponding button on the Internet site or at the following 
URL: 

● http://support.automation.siemens.com/WW/support/html_00/help/Online_Hilfe.htm 
(http://support.automation.siemens.com/WW/support/html_76/help/Online_Hilfe.htm) 

http://www.siemens.com/automation/support-request
http://support.automation.siemens.com/WW/view/en/16605032
http://support.automation.siemens.com/WW/view/en/21981898
http://www.siemens.com/automation/service&support
http://support.automation.siemens.com/WW/support/html_76/help/Online_Hilfe.htm
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WinCC FAQs 

Online Support with information on FAQs (Frequently Asked Questions) may also be found 
at the following URL: 

● http://support.automation.siemens.com/WW/view/de/10805548/133000 
(http://support.automation.siemens.com/WW/view/en/56732738/133000) 

Technical Forum 

The Technical Forum supports exchange with other SIMATIC users. It is available at the 
following URL: 

● http://www.siemens.com/automation/csi/forum 
(http://www.siemens.de/automation/csi_en/forum) 

Technical documentation for SIMATIC products 

You can find a guide to the technical documentation provided for individual SIMATIC 
products and systems at the following URL: 

● http://www.siemens.com/simatic-tech-doku-portal (http://www.siemens.com/simatic-tech-
doku-portal) 

Contact person database 

To contact your local agent, search our contact database at the following URL: 

● http://www.automation.siemens.com/partner/index.asp 
(http://www.automation.siemens.com/partner/index.asp?lang=en) 

Product Information  

SIMATIC Products 

Go to the following URL for additional information about SIMATIC products: 

● http://www.siemens.com/simatic (http://www.siemens.com/simatic) 

http://support.automation.siemens.com/WW/view/en/56732738/133000
http://www.siemens.de/automation/csi_en/forum
http://www.siemens.com/simatic-tech-doku-portal
http://www.siemens.com/simatic-tech-doku-portal
http://www.automation.siemens.com/partner/index.asp?lang=en
http://www.siemens.com/simatic
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See also 
Internet: Information on Information Server (http://www.siemens.com/wincc) 

Internet: Technical support (http://support.automation.siemens.com/WW/view/en/16605032) 

Internet: Automation Validation Card (AVC) 
(http://support.automation.siemens.com/WW/view/en/21981898) 

Internet: Service and Support (http://www.siemens.com/automation/service&support) 

Internet: Process Historian and Information Server FAQs 
(http://support.automation.siemens.com/WW/view/en/56732738/133000) 

Internet: Support Technical Forum (http://www.siemens.de/automation/csi_en/forum) 

Internet: Support Search (http://www.siemens.de/automation/csi_en/km) 

Internet: Support Online Help 
(http://support.automation.siemens.com/WW/support/html_76/help/Online_Hilfe.htm) 

Internet: Technical documentation for SIMATIC products (http://www.siemens.com/simatic-
tech-doku-portal) 

Internet: Contact person database 
(http://www.automation.siemens.com/partner/index.asp?lang=en) 

Internet: SIMATIC Products (http://www.siemens.com/simatic) 

http://www.siemens.com/wincc
http://support.automation.siemens.com/WW/view/en/16605032
http://support.automation.siemens.com/WW/view/en/21981898
http://www.siemens.com/automation/service&support
http://support.automation.siemens.com/WW/view/en/56732738/133000
http://www.siemens.de/automation/csi_en/forum
http://www.siemens.de/automation/csi_en/km
http://support.automation.siemens.com/WW/support/html_76/help/Online_Hilfe.htm
http://www.siemens.com/simatic-tech-doku-portal
http://www.siemens.com/simatic-tech-doku-portal
http://www.automation.siemens.com/partner/index.asp?lang=en
http://www.siemens.com/simatic
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 Information Server - Documentation 3 
3.1 Overview 

Introduction 
The SIMATIC Information Server is a reporting system that uses the Microsoft Reporting 
Services and accesses historic data of a process control system.  

The SIMATIC Information Server can be used to compile, evaluate and visualize the process 
values, messages and recipe data of a process control system in graphics or tables.  

The Process Historian server, WinCC stations and PCS 7 OS can be used as data sources. 
A network connection is required for access. 

Access the Web application of the Information Server with one of the following Web 
browsers that supports HTML5: 

● Microsoft Internet Explorer 

● Mozilla Firefox 

● Google Chrome 

The following applications are available for creating reports: 

● Information Server web application 

● Office add-ins for Microsoft Excel, Word and PowerPoint 

Access rights 
If you are connected to a Process Historian server or a PCS 7 OS/WinCC OS, you can 
access the archived data of projects that are released for you. The access rights required for 
this must be configured in the respective project. 

Reporting  
A variety of report templates are available for creating reports. You may use external 
applications to define further custom report templates. 

The reports and report templates are created by means of the web application or Office add-
ins. Use the same report templates in both applications. 

You can parameterize a report template, for example, by selecting a tag that contains the 
start and end time of the necessary monitoring period. The parameters you set define the 
report content.  

The selected report template determines the way the queried information is displayed. The 
results of the respective query are visualized in the report as tables or charts. 
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Evaluated data 

The Information Server provides report templates for the following data: 

● Process values 

● Messages 

● Batch logs (recipes) of SIMATIC BATCH 

● Process data analysis of the SIMATIC WinCC / Performance Monitor. 

The SIMATIC WinCC / Performance Monitor makes its own report templates available 
during installation. Additional information is available in the documentation of the 
Performance Monitor. 

 

 Note 

For more information about the report templates, refer to 'Report templates (Page 66)'. 
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Report layout 

The Information Server can visualize the queried data in various forms. You can output and 
save the reports "online" or export them to a local drive. 

The Information Server offers various options for creating, editing and viewing a report: 

● Preview 

Use the "Preview" menu entry to parameterize a report template that you can use to 
generate a report. This report is displayed in a preview window and is not saved.  

You can configure frequently used report templates to suit your requirements and store 
these along with these settings as "Presets" on the report server.  

● Saved report 

You can create reports in the following formats and save them on the: Information Server: 

– PDF 

– XML 

– HTML 

– MS Word 

– MS Excel 

● Export 

You can export the saved reports to a local drive for further processing. 

● Dashboard pages 

You can create your own dashboard pages for the presentation in the browser. A variety 
of layouts are available for this purpose. 

To design the dashboards, use the provided widgets, for example, for displaying a report 
or explanatory text. 

The displayed reports are updated when the dashboard is loaded and displayed as a 
snapshot. 

● Office add-ins 

You can create and view reports in Word or PowerPoint.  

Excel offers more options for processing the report data. 
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3.2 Example: Creating a report with data from Process Historian 

Introduction 
The following example shows you how to create a report in the Information Server with 
archived process data from Process Historian. 

Requirements 
● The Information Server has been installed. 

● A Web page has been created with the configuration manager. 

● The Internet Explorer has been set up according to the description in the Installation 
Notes. 

● You are logged on to the Web application of the Information Server in the role of 
"Administrator". 

● The Information Server has a network connection to a computer on which Process 
Historian is available. 

● The Process Historian must be activated. 

● The following licenses must be available: 

– License for the Information Server 

– Client-Access license for the Information Server 
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Procedure 
1. Open the Internet Explorer. Enter "http://<ComputerName>" to establish a connection to 

the Information Server. 

 
2. Enter the same user name and the same password that you specified in the configuration 

manager during the installation process. The Information Server Web application opens. 

 
3. Click the "Administration" menu item. 
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4. Click the "Configuration" menu item. 

5. Click the "Reporting" menu item. 

6. Click the "Project" menu item. 

7. Enter the computer name of the Process Historian in the "Server name or IP address" 
field. Select the "Process Historian" option. 

The standard name of the SQL instance is displayed. Check whether the standard name 
matches the connected Process Historian database. If necessary, change the name of 
the SQL instance. 
Click the "Select projects" button. 
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8. Select the project and click "Add". 

 
You have connected a Process Historian data source with the Information Server. 
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9. Click the "Reporting" menu item. 

 
10. Use a standard report template to access the data stored in the Process Historian. Select 

the "Table" template from the "Tags" folder. 

 
11. Click "Create report/Subscription". 
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12. Select a project. Specify a start time and an end time. Then click "Add" to select a tag. 

 
13. Use the "+" button to select a tag whose data you want to output in the report. 
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14. Click "Save". 
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15. Click "Show preview". 

 
The report is shown in the preview: 

 
16. Click "Create report". 
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17. Enter a name. Select the report format, such as "PDF". 

18. Click "Save". The report is listed in the list of reports. 

3.3 Information Server Web application - overview 

Introduction 
The Information Server Web application is the central location for the administration and 
management of report templates and subscriptions. 
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Structure of the web application  
 
Object/ Menu Area Use 
Frame: 
Navigate up 

- On all pages of the web application: 
• Current user, interface language 
• Log out, (arrow to right) 
• Breadcrumb bar to navigate within an Information Server 

portal 

Frame: 
Navigate left 

- Information Server portal: 
• Homepage 
• Dashboard 
• Reporting 
• Download 
• Administration 

Homepage - Overview of portal: 
• Dashboard 
• Reporting: 

– Reporting 
– Subscriptions 

• Download: 
– Office add-ins 

• Administration: 
– Configuration 
– E-mail settings 
– Licensing 
– Security settings (user management) 

Dashboard - Creation and viewing of dashboards 
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Object/ Menu Area Use 
Reporting - List of report templates for process values, messages and recipe 

data:  
• Report templates: 

– Display details 
– Select and configure or select the preset 
– Save as preset 

• Reports: 
– Create 
– Display 
– Edit 
– Download 
– Delete 

• Subscriptions: 
– Create 
– Display 
– Edit 
– Delete 

Download - SIMATIC Information Server add-in for MS Office 
Administration Configuration:  

Reporting > Project 
Establishing a connection with a Process Historian or PCS 7 or 
WinCC OS as the data source: 
• Data source 
• Authentication mode 
• User and password 
• Set a user-defined name for display in the Information Server 
Folder:  
• Create folder 
• Delete folder 
Selected access to existing projects: 
• Show settings 
• Specify authorizations 
• Delete project 

Configuration: 
Reporting > Templates 

Management of the report templates: 
• Create folder 
• Delete folder 
• Import report templates (upload) 
• Export report templates (download) 
• Delete report templates 
• Move report templates 
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Object/ Menu Area Use 
E-mail settings Specifying settings of the SMTP mail server for sending reports 

by e-mail: 
• Server IP/ name 
• Port 
• Email address of the sender 
Test connection for verification:  
• E-mail address of a recipient for the test e-mail 

Licensing Display the status of licenses, sorted by installed and used li-
censes: 
• Server 
• Client access 
• Data source access (WinCC) 
• Data source access (PCS 7) 

Users List of users that have been created in the Windows groups. 
The user profile shows the assigned roles under "Permissions". 
Use "Language" to select the user interface language of the web 
application. 
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3.4 Administration 

3.4.1 Configuration 

Information Server Configuring the web application 
The configuration manager is executed on completion of the setup during the initial start of 
the operating system. It determines, among other things, the HTTP address via which 
access is provided to the Information Server.  

 

 Note 
Configuration of the Internet Information Services (IIS) 

The configuration of the Internet Information Services (IIS) may not be changed for the 
Information Server. 

 

Opening the Information Server web application 

Requirement 

● The user must be a member of the user groups "SIMATIC Report" in the Windows 
computer administration. 

For more information about the user groups, refer to "User management (Page 62)". 

Opening the Information Server website 

Enter the address (URL) that corresponds with configuration "1" or "2" in the address bar of 
the browser. 

 
Page view IIS Configuration of the operating mode Use 
http://localhost Configuration 1 Locally on the Information Server 
http://<PC name> Configuration 1 From the network 
http://localhost/informationserver Configuration 2 Locally on the Information Server 
http://<PC name>/Informationserver Configuration 2 From the network 

 

 

 Note 
Releasing licenses by logging out from the Web application 

Use the "Logout" link to log off from the Web application. 

If you close the browser without logging out, the client license remains in use until the 
session closes. 
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 Note 
Internet Explorer does not display Information Server 

If the Internet Explorer does not display the Web application of the Information Server, check 
the Internet Information Services (IIS), the Reporting Services and the .NET 
Framework 4.5.1 installation. 

You must confirm the .NET Framework 4.5.1 settings after the registration of IIS. 
 

Managing folders 
You can create new folders and delete existing folders to manage projects and report 
templates. 

Requirement 

● You are a member of the "SIMATIC Report Administrators" Windows group: 

Create folder 

1. Click "Administration > Configuration > Reporting". 

2. Click "Create Folder" under "Project" or "Templates" in the respective directory. 

3. Enter the desired name for the folder and confirm with "OK". 

The folder is created in the list of project folders. 

Delete folder 

1. Click "Administration > Configuration > Reporting". 

2. Click on the folder to be deleted under "Project" or "Templates" in the respective 
directory. 

3. Click "Delete Folder". 

4. Confirm the security prompt. 

The folder is deleted. 

See also 
Connect data source (Page 63) 

User management (Page 62) 
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3.4.2 User management 
Under "Users" in the "Administration" portal, you can see the list of users that have access to 
the. Information Server. 

The list shows details about the user: 

● User name 

● Display name 

● E-mail address (optional, can be changed) 

Authorizations with the assigned Windows user groups are displayed via the "View" link. 

When you click the user name in the header area of the frame, the user profile for the 
logged-on user opens. You can change the interface language of the Web application there, 
for example. To reset user-specific view settings, click "Delete all status data of the 
application". 

Authorizations 
You use the Windows Computer Management for user management and assignment to the 
Windows user groups. 

The Information Server uses the following local Windows user groups: 

● SIMATIC Report Administrators: Installing and configuring the Information Server 

● SIMATIC Report Publishers: Creating and downloading reports 

● SIMATIC Report Services: Creating connections to a data source 

● SIMATIC Report Users: Viewing reports 

● SIMATIC Report Viewers: Read access to reports under "Public" 

 

 Note 
Opening the web application locally on the Information Server 

If you use an operating system with active user account control, such as Windows 7, 
Windows Server 2008 or Windows Server 2008 R2, it may also be necessary to start the 
web application as an Administrator with advanced rights. 
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Rights for the connection to data sources 
Connection of PCS 7 projects, WinCC projects or Process Historian archives is made in the 
Information Server via the "Administration" portal in the "Projects" area. 

The following rights must be assigned to the user groups for this process: 

● SIMATIC Report Administrators: Users that log on via the Web interface and are 
permitted to work in the "Administration" area. 

● SIMATIC Report Services: Creating connections to a data source.  

This user must exist on both the Information Server and on the PC where the data source 
is located and requires comprehensive rights to the data source. 

In the case of a WinCC data source, the user must have SIMATIC HMI rights. 
 

 Note 
Connecting data sources 

For more information about connecting projects, see section "Connect data source 
(Page 63)". 

 

 

See also 
Configuration (Page 60) 

3.4.3 Connect data source 
To gain access to project data, connect the Information Server to a data source. 

You can work with the following data sources: 

● PCS 7 project 

● WinCC projects 

● Process Historian database 

● WinCC OA 

 

 Note 
Project archive 

You can create folders to structure projects. Whether an available project is a PCS 7 project 
is indicated in brackets.  

Assign an alias name to projects of the same name. 
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Requirement 
● You are logged on to the Web application of the Information Server in the role of 

"Administrator". 

● The Information Server has a network connection to a computer on which the data source 
is available. 

● In the case of a connection to Process Historian, Process Historian must be activated. 

Procedure 
1. Select "Administration" in the navigation area. 

2. Select "Configuration > Reporting". The configuration screen for the reporting is 
displayed. 

3. Under "Connect projects" in the "Project" view, enter the server name or IP address in the 
text box. 

4. Select the data source under "Type". 

The standard name of the SQL instance is displayed. With a connection to Process 
Historian, check whether the default name matches the SQL instance of the connected 
Process Historian database. If necessary, change the name of the SQL instance. 

5. Click "Select projects". 

The connection to the data source is established. 

The available projects are displayed. 

6. Select the desired projects. 

7. Select "Add" to connect the projects. 

Result 
A connection is established with the selected project. 

The data of the project are available for report creation. 
 

 Note 
Reconnecting data source (PCS 7 OS/ WinCC) 

If the database name on the PCS 7 OS or WinCC station changes, you have to reconnect 
the project under "Administration > Projects".  

Prior to this, you must remove the connection that is already configured. 
 

See also 
Configuration (Page 60) 

User management (Page 62) 
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3.4.4 Editing e-mail settings 
You have to specify the settings of the SMTP mail server to send reports by e-mail. 

Requirement 
● You are logged on to the web application of the Information Server in the role of 

"Administrator". 

Procedure 
1. Select the "E-mail settings" in the "Administration" portal. 

2. Enter the required data in the 'Settings of the SMTP mail server' area: 

– Server IP/ name 

– Port 

– Email address of the sender 

3. Click "Apply" to save the settings. 

Click "Reset" to reset a configuration, if necessary. 

4. Enter the e-mail address of a recipient in the 'Test connection' area. 

5. Save the email configuration before testing. 

6. Click "Send" to check the set configuration. 

A test e-mail is sent. 

Result 
You have changed the e-mail setting of the Scheduler. 
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3.5 Reporting 

3.5.1 Report templates 

3.5.1.1 Report templates - Overview 
The Information Server provides report templates for the following data: 

● Messages 

● Process values 

● SIMATIC BATCH logs 

● Process data analysis of the SIMATIC WinCC / Performance Monitor. 

The SIMATIC WinCC / Performance Monitor makes its own report templates available 
during installation. Additional information is available in the documentation of the 
Performance Monitor. 

 

 Note 
FAQs for the creation of customized report templates 

In addition to the above named templates, you can create customized report templates for 
the Information Server based on Process Historian data in the WinCC and PCS 7 
Environment. 

You can find additional information in the following FAQs: FAQs on the creation of 
customized report templates 
(https://support.industry.siemens.com/cs/document/64906050/creation-of-report-templates-
for-the-information-server-based-on-process-historian-data-in-the-wincc-und-pcs-7-
environment?dti=0&lc=en-WW) 

 

https://support.industry.siemens.com/cs/document/64906050/creation-of-report-templates-for-the-information-server-based-on-process-historian-data-in-the-wincc-und-pcs-7-environment?dti=0&lc=en-WW
https://support.industry.siemens.com/cs/document/64906050/creation-of-report-templates-for-the-information-server-based-on-process-historian-data-in-the-wincc-und-pcs-7-environment?dti=0&lc=en-WW
https://support.industry.siemens.com/cs/document/64906050/creation-of-report-templates-for-the-information-server-based-on-process-historian-data-in-the-wincc-und-pcs-7-environment?dti=0&lc=en-WW
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Configuration of report templates 
You can assign different parameters to a report template. The basic parameters for process 
values and messages include: 

● Project name 

● Start time 

● End time 

Time that you can specify as absolute time or relative, for example: 

● Absolute time: 2 February 2014, 10:30 AM 

● Relative time: The last two hours since the creation time of the respective report. 

You may specify additional parameters, depending on the report template you selected. 

You can only change the following parameters of a created report template: 

● Name 

● Comment 

● Format 

You can find more information on the time specifications on the page Time specifications 
(Page 68) 

Templates for messages 
In templates for messages, you can, for example, specify message classes, the number of 
displayed values or a source. You can find more information on page Templates for 
messages (Page 71) 

Templates for process values 
In templates for process values, you specify concrete tags that you can select from the 
following archives: 

● Process value archive 

● Compressed archive 

You can assign additional parameters such as a statistical calculation method or a relative 
timestamp. 

You can find more information on page Templates for process values (Page 72) 

Templates for SIMATIC BATCH batch reports 
In PCS 7, Information Server provides the report template "Batch Stepping Protocol" for 
batches by default. A separate SIMATIC BATCH add-on is available for this purpose. 
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Templates for Excel reports 
You can store templates that were created in Excel as ERT (Excel Report Template) files in 
a report template folder in the Information Server. Excel templates include their own layouts, 
texts and contents.  

You use the Excel templates in the Web application of the Information Server to create a 
subscription. You cannot create reports with Excel templates in the Web application. 

All configurations that you have created in Excel are retained in the Excel templates.  

See also 
Templates for messages (Page 71) 

Templates for process values (Page 72) 

Time specifications (Page 68) 

3.5.1.2 Time specifications 

Relative time specifications 
Relative time specifications are placeholders for a time period. The time period has no 
absolute start or end time. A relative time specification therefore requires a reference time.  

The reference time can be absolute or relative. If there is a plus sign before the relative time 
specification, the time period given is after a reference time.  

A leading minus sign indicates that the period is in advance of a reference time. 

The following table shows the available relative time specifications: 
 
Relative time spec-
ification 

Time unit Web application Office add-ins 

ms Millisecond ✓ ✓ 
s Second ✓ ✓ 
m Minute ✓ ✓ 
h Hour ✓ ✓ 
d Day ✓ ✓ 
w Week ✓ ✓ 

mo Month ✓ ✓ 
y Year ✓ ✓ 
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The following table shows the separate relative time specifications: 
 
Relative time spec-
ification 

Time unit Web application Office add-ins 

t Current day ✓ ✓ 
y Yesterday ✓ ✓ 
* Current time ✓ ✓ 

1-31 1st - 31st of the 
month 

✓ ✓ 

Special feature of relative time specification "y": 

The relative time specification "y" designates both a "Year" and "Yesterday". The context in 
which the "y" is used determines the relative time specification. 
When the "y" is used at the start of the time period, it represents the relative time 
specification "Yesterday". 
When the "y" is used in combination with a number, it stands for the relative time 
specification "Year". 

Special feature of the relative time specification "1-31": 

The relative time specification "1-31" includes all numbers between 1 and 31.  
When one of these numbers is not used in direct combination with another relative time 
specification, the number stands for this day of the month. 

Examples for relative time specifications 
The following table gives examples of relative time specifications: 
 
Example Description 
13.01.2012 10:00:00+1d-2h+30m 13.01.2012, 10:00 AM plus one day minus 2 

hours plus 30 minutes 
*-24h+30m Current time minus 24 hours plus 30 minutes 
t-3m 12:00 AM of the current day minus three minutes 
2y-3mo 2 years minus 3 months 
y-15h 12 AM of the previous day minus 15 hours 
12 The 12th of the month 

Absolute time specification 
An absolute time specification defines a specific time. 

The following table shows the possible absolute time specifications: 
 
Absolute time 
specification 

Time unit Web application Office add-ins 

dd.mm.yyyy 
hh:mm:ss 

Date with time speci-
fication 

✓ ✓ 



Information Server - Documentation  
3.5 Reporting 

 SIMATIC Information Server 
70 System Manual, 05/2017, A5E38560846-AB 

Examples for absolute time specifications 
The following table gives examples of absolute time specifications: 
 
Example Description 
12.08.2012 Specified date 
10.03.2009 14:00:00 2:00 PM on the specified date  

Combined time specifications 
A combined time expression is a specific reference time followed by a relative time 
expression. 

The following table gives examples of combined time specifications: 
 
Combined time specification Description 
*-2d+10h Current time minus two days, plus ten hours 
t+32s Current day, midnight plus 32 seconds  

 

 

 Note 
Times in different time zones 

If different time zones are set on the Information Server and Information Server client, the 
local time zone of the server is displayed in the reports. 
Times in MS Excel 

Timestamps entered in cells are read during configuration of tags in Excel. 
 

 

See also 
Report templates - Overview (Page 66) 
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3.5.1.3 Templates for messages 
The Information Server has the following report templates for messages:  
 
Template Description 
Acknowledgment duration Frequency distribution chart: Number of messages within a defined time 

interval requiring acknowledgment, sorted by acknowledgment duration 
(duration from occurrence of message until acknowledgment). 

Messages per day Bar chart: Number of messages requiring acknowledgment per day, 
classified by message class. 

Messages by origin Bar chart: Number of messages by origin, sorted in descending order. 
Only messages requiring acknowledgment are considered. 

Messages by priority Bar chart: All messages by priority (messages requiring acknowledg-
ment). 

Messages per 10 minute 
period 

Histogram: Number of messages per 10 minute period as time-related 
measure. According to EEMUA, more than 10 messages within a 10 
minute period indicate the start of a message burst during which mes-
sages are displayed faster than they can be processed by the operator. 

Messages by priority Pie chart: Number of messages requiring acknowledgement by priority. 
Average acknowledgment 
duration 

Bar chart: Number of messages by average acknowledgment duration 
of messages within a time interval. 

Messages filtered by mes-
sage class 

Table: All messages of a selected message class. 

Messages sorted by priori-
ty 

Table: All messages sorted by priority. 

Messages sorted by 
timestamp 

Table: All messages sorted by timestamp. 

Commented messages Table: All commented messages. 
Quantity by message class Bar chart: Number of messages for all message classes. 
Total duration until ac-
knowledgment 

Bar chart: Hit list of messages requiring acknowledgment sorted by total 
duration until acknowledgment. All acknowledgment durations are to-
taled individual acknowledgment durations: Time period from "came" to 
"acknowledged". 

Total duration until gone Bar chart: Hit list of messages requiring acknowledgment sorted by total 
duration until acknowledgment. All acknowledgment durations are to-
taled individual acknowledgment durations: Time period from "came" to 
"gone". 

See also 
Report templates - Overview (Page 66) 
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3.5.1.4 Templates for process values 
The Information Server has the following report templates for process values: 
 
Template Type Area Description 
Aggregation trend Trend 

chart 
Defined time interval Aggregated tags within a defined timer 

interval. 
Trend Trend 

chart 
Defined time interval Tags within a defined timer interval. 

Aggregation matrix Table Defined time interval Compiled tags within a defined timer inter-
val in columns. 

Matrix Table Defined time interval Tags within a defined timer interval in col-
umns. 

Aggregation table Table Defined time interval Compiled tags within a defined timer inter-
val in continuous sequence. 

Table Table Defined time interval Tags within a defined timer interval in con-
tinuous sequence. 

Archive configuration Table Selected tags Archive configuration of selected tags. 
Archive configuration 
chain 

Table All derived archive 
tags 

Archive configuration of selected tag includ-
ing all derived archive tags. 

 
 

 Note 
Differing process values 

Compressed process values can significantly differ from the process values stored in the 
archive. The deviation depends on the compression algorithm used. 
Delayed display of current process values 

Depending on the method of storage and compression algorithm, current process values 
may be stored in the database with a time delay. In this case, the archive values are not 
collected, for example, until the defined size of the data packet is reached. Only then will the 
archive values be transferred to the database. 

This behavior may cause the process values of the last 10 minutes to be missing in the 
report, for example. 

To view the process values from this period, update the report after a few minutes. 
 

See also 
Report templates - Overview (Page 66) 



 Information Server - Documentation 
 3.5 Reporting 

SIMATIC Information Server 
System Manual, 05/2017, A5E38560846-AB 73 

3.5.2 Working with the Web application 

3.5.2.1 Working with the web application 
The Information Server web application is designed for easy and intuitive operation.  

The basic operator actions are summarized in this section. 
 

 Note 
Releasing licenses by logging out from the Web application 

Use the "Logout" link to log off from the Web application. 

If you close the browser without logging off, the client license remains occupied until the 
session is closed. 
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Layout of the homepage 
The frame remains unchanged during the use of the Information Server. This allows the user 
profile with the language settings and logoff to be performed at any time. 

The menu navigation of the selected portal is displayed as title path in the header area of the 
frame. 

 
You can see the Information Server portal in the work area: 

● Dashboard 

● Reporting (report creation) 

● Download 

● Administration 

The applications and the start view can also be accessed via the left navigation bar. 

Clicking on the arrow below the last icon expands or minimizes the bar to a desired size. 
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Basic commands 
You can use the following basic commands in the Information Server: 

● Move element to another folder 

● Upload element 

● Download element 

● Edit element 

● Delete element 

The commands for processing an element are similar as those under Microsoft Windows. 

Language change 
1. Click on on your user profile at the right top of the screen. 

The user profile is displayed. 

2. Click on the currently selected language in the "Language" line. Select the desired 
language. 

3. Click "Save". 

The web application is updated and takes on the current language settings. 
 

 Note 
Changing the user interface language 

If the user interface language is not displayed correctly, check to see if you have installed the 
operating system and Microsoft Office with the matching Multilingual User Interface. 

 

See also 
Working with Office add-ins (Page 88) 
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3.5.2.2 Creating a report 

Creating a report 
You have the following options for creating reports: 

● View online via the preview 

● Save with "Create report" on the Information Server 

● Local saving via downloading a created report 

● Local saving via a subscription 

● Sending via an e-mail via a subscription 

Options for creating a report 

If you save a report on the Information Server, you can specify the following settings: 

● Name of the report 

● Comment for describing the report 

● Storage location 

If you disable the "Private" option, all Information Server users have access to the report. 

● Online report 

To view the report in the browser, select the "Online report" option. 

● Export format 

Select the desired format for saving the report. 

– PDF 

– XML 

– HTML 

– MS Word 

– MS Excel 

Saving parameter presets 
When you create a report frequently with the same parameters, you can save these 
parameters as presets for the report template. 

Procedure 

1. Select "Create parameter preset" button after configuring the report. 

2. In the "Create preset for report parameters" dialog, enter a name. 

3. If the preset should be visible for all users, disable the "Private" option. 

The configured report template is displayed with the "Create Report/Subscription" button 
from the drop-down list. 

Click "Manage presets" to edit, sort and delete the parameter presets. 
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Requirement 
● A connection to the Process Historian Server or PCS 7 OS/ WinCC OS has been 

established. 

Procedure 
1. On the homepage of the Information Server, select the "Reporting" application. 

2. Select a template under "Report templates" in the navigation bar. 

The reporting and subscription lists are displayed. 

3. Select "Create report/subscription". 

The parameter input fields for the report template are displayed. 

4. Select a project. 

5. Assign the parameters to the report template with the required specifications, for 
example: 

– Start: Start time with date and time 

– End: End of the time period with date and time 

– Tags: Tag whose value is displayed 

6. To create the report, click "Show preview". 

7. To save the report in the Information Server, click "Create report". 

The "Create report" dialog opens. 

8. Specify the settings. 

9. The report is created and displayed in the report list of the report template. 
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Alternative procedure: Apply presets 
If a configured report template is saved, you can use "Manage presets" to apply these 
settings.  

1. On the homepage of the Information Server, select the "Reporting" application. 

2. Select a template under "Report templates" in the navigation bar. 

3. Use the right arrow on "Create report/subscription" button to open the list of saved 
presets. 

4. Select the desired preset. 

The parameter input fields for the report template are displayed. 

5. If necessary, change the displayed parameters. 

6. Follow the procedure for creating a report. 

Result 
The created report is now in the report list of the selected template. 

You can view, download, edit or delete the report. 

3.5.2.3 Working with subscriptions 

Settings for subscriptions 

Introduction 
To automatically create a report at a future point in time, you can create a subscription. 

Reporting via a subscription can be started by various triggers: 

● One-time creation of a report at a specific point in time, for example, by starting an 
analysis at the beginning or end of the week. 

● Cyclic creation of a report at a recurring point in time, for example, to regularly obtain an 
analysis of the previous week every Monday. 

● Reporting initiated by an event, for example, when a tag limit is exceeded or a specific 
message is triggered. 
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General Settings 
You can make the following settings for all subscriptions: 

● Private 

If you disable the "Private" option, all Information Server users have access to the 
subscription. 

● Online report 

To view the report in the browser, select the "Online report" option. 

● Enabled 

If you disable the option, the subscription is paused.  

The reporting is not performed until the subscription is enabled again and the condition 
for the trigger occurs. 

● Export format 

Select the desired format for saving the report. 

– PDF 

– XML 

– HTML 

– MS Word 

– MS Excel 

● Storage location or settings for sending by e-mail 

You cannot change the parameters of the subscribed report. 

Notification via e-mail 
You can also activate that the report is sent by e-mail.  

The following options are available:  

● E-mail 

The e-mail contains the report as an attachment. 

● E-mail (with link) 

The e-mail contains a link to the report in the specified target directory. 

Enter the following settings: 

● Email address of the recipient 

If necessary, add more e-mail addresses under "CC" or "BCC". 

● The subject of the e-mail 

● Priority of the e-mail 

● Message text in the "Message" field 

● Return address (optional) 
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Trigger 
You can select the following triggers for a subscription: 

● Tag trigger 

● Message trigger 

● Time trigger 

Tag trigger 

1. Select the data source and the desired project. 

2. Use "Add" to select the triggering tag. 

3. Select whether the tag trigger is triggered by any change or when a limit is reached. 

Enter the desired limits if needed. 

Message trigger 

1. Select the data source and the desired project. 

2. Use "Add" to select the triggering message. 

 

 Note 

When tag and message triggers are used, reports are only output about events when the 
time between two events is greater than 1 minute. 
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Time trigger 

To trigger a report once, select the desired date and time. 

To create a a report cyclically, select "Recurring" and specify the following settings: 

● Beginning 

The starting time for the cyclic creation 

● End (optional) 

Maximum period for which the subscription is active 

● "Daily" or "Weekly" or "Monthly" field 

Maximum number of report creations, for example, three days in a row 

● Frequency 

– Daily 

Once: At a specific time  

Recurring: At specific intervals of hours or minutes ("Interval" field) within the period 
between "Beginning" and "End" 

– Weekly on the selected days of the week 

Once or recurring (see settings under "Daily")  

– Monthly on a specific date, for example, e.g. each month on the 5th day of the month 
or on a specific weekday, such as on the 3rd Monday of each month 

Once or recurring (see settings under "Daily")  

Only relative time information is useful for configuring a recurring subscription. 

For additional information, refer to "Time specifications (Page 68)". 

 

See also 
Creating subscriptions (Page 82) 

Time specifications (Page 68) 



Information Server - Documentation  
3.5 Reporting 

 SIMATIC Information Server 
82 System Manual, 05/2017, A5E38560846-AB 

Creating subscriptions 

Introduction 
In a subscription, you specify the content- and time-based criteria for the creation of reports. 
You can find the available settings for a subscription under Settings for subscriptions 
(Page 78). 

Only relative time information is useful for configuring a recurring subscription. 

List of subscriptions 
To view all subscriptions, select the "Subscriptions" area in the "Reporting" portal. 

To view the subscriptions for a specified report template, select the desired report template 
in the "Reporting" portal. The report list contains the subscriptions that are based on this 
report template. 

You can edit and delete the subscription displayed in this list. 
 

 Note 
All-day recurring subscriptions 

If you want to create a subscription which creates recurring reports around the clock for you, 
then define the start time as 00:00. 

 

Requirement  
● A connection to the Process Historian Server or PCS 7 OS/ WinCC OS has been 

established. 

Procedure 
1. On the homepage of the Information Server, select the "Reporting" application. 

2. Select a template under "Report templates" in the navigation bar. 

The reporting and subscription lists are displayed. 

3. Select "Create report/subscription". 

If presets have been saved for the report, you can optionally apply these settings. 

4. Set the parameters for the subscription with the required specifications. 

You can view the report with "Show preview". 

5. Click "Create subscription" and enter the desired settings. 

6. Click "Save". 
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Result 
A subscription is created for the selected report and shown in the list of subscriptions. 

You can view, download, edit, disable, enable or delete the subscription. 

 

See also 
Creating a report (Page 76) 

Time specifications (Page 68) 

3.5.2.4 Managing report templates 

Uploading report template 

Introduction 
You can upload report templates from the PC to the Information Server. 

Requirement 
● A report template is saved locally on the PC. 

Procedure 
1. Select "Administration" in the navigation area. 

2. Select "Configuration > Reporting". 

The configuration screen for the reporting is displayed. 

3. Click on the target folder in the "Templates" view. 

4. Click "Upload" in the "Templates" view. 

The existing report templates are loaded. 

5. Select the desired report template. 

6. Complete the process with "Upload". 

 

 Note 

SQL queries affect the availability of the Process Historian and/or the WinCC server as well 
as the Information Server. 

 

Result 
The uploaded report template is located in the selected target folder. 
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Downloading report templates 

Introduction 
You can download report templates from the Information Server locally to the PC. 

Requirement 
● An report template is stored on the Information Server. 

Procedure 
1. Select "Administration" in the navigation area. 

2. Select "Configuration > Reporting". 

The configuration screen for the reporting is displayed. 

3. In the "Templates" view, click on the folder in which the report template is located. 

4. Select the desired template and then click "Download" in the same line. 

The template is downloaded. 

5. The remaining procedure depends on the browser used. 

 In most cases, the downloaded template is stored in the "Downloads" folder. 

Result 
A report template is saved on the PC. 
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Moving report templates 

Requirement 
● An report template is stored on the Information Server. 

Procedure 
1. Select "Administration" in the navigation area. 

2. Select "Configuration > Reporting". 

The configuration screen for the reporting is displayed. 

3. In the "Templates" view, click on the folder in which the report template is located. 

4. Select the template and then click "Move" in the same line. 

The "Move template" dialog opens. 

5. Select the destination directory. 

Result 
The report template is located in the selected target folder. 
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Deleting report templates 

Effects 
When you delete a report template, the following associated objects are also deleted: 

● Created reports 

● Subscriptions 

Requirement 
● A report template is available on the Information Server. 

Procedure 
1. Select "Administration" in the navigation area. 

2. Select "Configuration > Reporting". 

The configuration screen for the reporting is displayed. 

3. In the "Templates" view, click on the folder in which the report template is located. 

4. Select the template and then click "Delete" in the same line. 

5. Confirm the prompt with "Yes". 

Result 
The selected element is deleted. 
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Uploading Excel templates 

Requirement 
● An Excel template is available. 

Procedure 
1. Select "Create report" in the navigation area. 

2. Select the "Excel templates" tab. 

3. Select the folder to which the Excel template is to be saved. 

To create a new folder, enter a folder name and then click "Create". 

4. Click "Upload". 

5. Navigate to the storage location for the Excel template. 

6. Select the desired Excel template and then click "Upload". 

Result 
An Excel template is available in the web application. 
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3.5.3 Working with Office add-ins 

3.5.3.1 Integrating Office add-ins 

Introduction 
You can download the installation files for Microsoft Office add-ins from the homepage of the 
Information Server web application. 

The Office add-ins are a technical prerequisite for inserting reports in Microsoft Word, 
PowerPoint and Excel, or for editing in Excel.  

The setup routine of the SIMATIC software guides you through the installation. For additional 
information, refer to the Installation Notes. 

 

 Note 

The concurrent use of different Office versions on one computer is not supported. 
 

Office add-ins 
The Office add-in for Word and PowerPoint can be used to complete the following tasks: 

● Creating a report 

● Inserting a report 

● Connecting Information Server 

The Office add-in for Excel can be used to complete the following tasks: 

● Configuring a report template 

● Inserting a report 

● Inserting and editing process values 

● Inserting and editing messages 

● Filling report templates with archive data 

● Graphically evaluating process values 

● Saving a report 

● Opening saved reports 

● Connecting Information Server 

You may use the Office add-ins to insert reports you have already created as graphic image.  
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Requirement 
● The Office applications Word, PowerPoint and Excel are installed on the system. 

● The Office applications are closed. 

● You have administrator rights on the local PC. 

Procedure 
1. Start the Information Server web application. 

2. In the "Download" portal, download the installation package of the Office add-in. 

3. Select a storage location for the EXE file. 

4. Run the software setup. 

5. Follow the instructions of the installation wizard. 

6. Click "Finish" to complete installation. 

Result 
You have successfully integrated the Office add-ins in the installed Office applications. 

Once the Office application starts, the menu bar contains a new "Information Server" tab. 
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3.5.3.2 Linking Office add-ins with the Information Server 

Requirement 
● Microsoft Word, PowerPoint and/ or Excel are installed. 

● The Information Server and the Office add-ins are installed. 

Procedure 
1. Start the Office application. 

At the initial start after the installation of the Office add-ins, the "Select server" dialog box 
opens. 

2. Enter the name of the computer on which the Information Server is installed to establish a 
connection. Confirm your selection with "OK". 

If you use an HTTPS connection, enter the PC name. It is not possible to connect via 
"https://localhost". 

A logon dialog for authentication opens. 
 

  Note 

The structure of the connection string depends on the configuration of the Information 
Server website. The configuration of the website is described in the 'Configuration' 
section of the administration manual. 

The following entries are possible:  
• <Computer name> 
• <Computer name>/Informationserver 

 

3. Enter the user name and password and confirm with "OK". 

The settings for the connected server are still available the next time you open the Office 
applications. 

Result 
You are connected to the Information Server. You can use Office applications to edit the 
report templates and create reports. 
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3.5.3.3 Reports in Office applications 

Introduction 
The Information Server has add-ins for Excel, Word and PowerPointMicrosoft applications. 
These add-ins can be used to create and insert reports in Excel, Word and PowerPoint. 

The Office applications distinguish between two types of reports: 

● Report templates 

You can create a report on the Information Server and integrate it as a graphic in an 
Excel, Word or PowerPoint file. The report creation corresponds to the procedure in the 
Information Server web application. 

● Excel report templates 

You can create report templates for Excel. Process values or messages are inserted into 
the cells of an Excel worksheet. You can update the cell contents when you use relative 
time information.  

You can continue processing the data with the Excel functions. You can visualize the 
process value progress with the Excel graphic function, for example. 

A connection to an Information Server must be established to call up information for a report. 
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Information Server tools for Excel, Word and PowerPoint 
The following table explains the tool functions provided by the Excel or Word and 
PowerPoint add-ins: 

 
Symbol Application Function 

 

Excel, Word and PowerPoint Creating a new report based on a report template 

 

Excel, Word and PowerPoint Creating and inserting a report based on a configured report template 

 

Excel Inserting and editing tags 

 

Excel Inserting and editing messages 

 

Excel Reading out data for configured tags or messages from the Pro-
cess Historian database or PCS 7 or WinCC OS 

 

Excel Opening an Excel report template from a file or from the Infor-
mation Server 

 

Excel Storing an Excel report template into a file or on the Information Server 

 

Excel, Word and PowerPoint Connecting Information Server 

 

 

 Note 
Display of queries with multi-page results in Word 

In the case of queries with multi-page results, it is always only the first page that is displayed. 
 

See also 
Linking Office add-ins with the Information Server (Page 90) 
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3.5.3.4 Configuring Properties of an Archive Tag 

Introduction 
To insert a tag into an Excel spreadsheet, open the "Add Tag" dialog on the "Information 
Server > Tags > Insert" tab. 

Specify the layout and configuration of the tags in the "Properties" area. 

Layout settings of a tag 
The layout settings are displayed by the "Insert Tag" dialog in the "Properties" area of the 
"Layout" tab. 

The following table provides an overview of the layout settings of a tag: 
 
Selection Settings Description 
Spreadsheet, cell Coordinates Specifies the target cell of the tag. 
Alignment Vertical 

Horizontal 
Specifies the representation of the determined process values. 

Heading Header 
Footer 

Specifies if and where a heading for the tag is displayed. 

Timestamp Left 
Right 

Specifies where the timestamp of the process value is displayed, to the left 
or right of the displayed process value. 

Quality code Left 
Right 

Specifies where the quality code of the process value is displayed, to the 
left or right of the displayed process value. 

Tag configuration 
The configuration settings are displayed in the "Insert Tag" dialog in the "Properties" area of 
the "Configuration" tab. 

The following table provides an overview of the configuration settings of a tag: 
 
Selection Settings Description 
Start Option field for date and time By selecting the date and time, you specify a start time for the data 

query. 
End Option field for date and time By selecting the date and time, you specify an end time for the 

data query. 
Time series "Settings..." button  

> "Time series" dialog box 
In "Time series" mode, you can specify whether the original pro-
cess values or interpolated values are displayed.  

Calculation "Settings..." button  
"Calculation" dialog window 

In "Calculation" mode, you specify a "Time interval" for which an 
aggregate is formed. In the "Calculation mode" field, you can se-
lect from the calculation methods from which an aggregate of the 
process values is determined. 

For more detailed information on the settings for "Time series" and "Calculation", refer to the 
section Editing a tag in Excel (Page 99) 
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3.5.3.5 Selecting an Information Server 

Introduction 
You can use the multifunction bar to connect to a different server while working in Excel, 
Word or PowerPoint. 

Requirement 
● There is a network connection to the Information Server. 

Alternatively: 

● The Office add-ins are installed locally on the client computer. 

Procedure 
1. Click the "Server" icon in the multifunction bar. 

The "Select server" dialog opens. 

2. In the drop-down list, select the Information Server or enter the name of a server to which 
a connection is to be established. Click "OK". 

Alternatively, you can enter an IP address. 

Result 
You have made a connection to the selected server. 

 

 Note 
No connection to Information Server 

If you could not establish a connection to the Information Server, check whether an 
appropriate license is available and whether there are network problems. 
Multifunction bar not active 

If there is no connection to the Information Server or no connection could be created, the 
multifunction bar commands are disabled.  
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3.5.3.6 Editing reports 

Inserting a report via Office add-ins 

Introduction 
Report templates that are stored on the Information Server can be inserted in Office 
applications. 

The function "Insert Report" of the Office add-ins for Excel, Word and PowerPoint is 
identical. 

Requirement 
● A report template is available. 

● You are connected to the Information Server. 

Procedure 
1. Click the "Insert" icon in the multifunction bar. 

The "Insert report" dialog opens. 

2. Navigate to the required report and select the report template. 

3. Click "Insert". 

Result 
A report template is inserted in the active Office application. 
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Creating a report 

Introduction 
The Office add-ins of the Information Server can be used to insert reports in Excel, Word and 
PowerPoint. 

With the Office add-ins, you create a report with the same report templates as in the web 
application. The function "Create Report" of the Office add-ins for Excel, Word and 
PowerPoint is identical. 

Requirement 
● You are connected to the Information Server. 

Procedure 
1. Click the "Create" icon in the multifunction bar of the Information Server add-ins. 

The "Create report" dialog opens. 

2. Select the report template you want to use. 

When you have selected a report template, the "Template settings" area lists the 
parameters of the selected report template. 

3. If several projects are available, from the "Projects" drop-down list select the required 
project from which the values are to be retrieved. 

If only one project is available, this is automatically active. 

4. Assign parameters to the report template. 

5. Click "Create". 

Result 
A report is created in the active Office application. 
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Inserting a tag in Excel 

Requirement 
● You are connected to the Information Server. 

Procedure 
1. Click the "Tags > Insert tags" icon in the multifunction bar. 

The "Insert tag" dialog opens. 

2. Select the project from which the process values are to be called from the drop-down list. 

3. Select the required tag with a double-click/click. Confirm the action with "OK". 

4. Click "Insert" and the selected tag is inserted into the highlighted cell. 

Result 
A tag is inserted in the Excel worksheet with a minimum configuration. 
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Configuring a tag in Excel 

Requirement  
● You are connected to the Information Server. 

Procedure 
1. Click "Insert tag" in the multifunction bar. 

You can also select a tag in the Excel worksheet and click "Edit tag". 

The "Edit tag" dialog is displayed. 

2. You can select tags from the process value archive or from the compressed archive. 

3. Configure the representation of tags in the "Properties" area in the "Layout" tab: 

– Target cell in the Excel worksheet 

– Orientation in the document 

– Display and orientation of the title 

– Position of the timestamp 

– Orientation of the quality code 

4. Specify the following criteria of the process values in the "Configuration" tab: 

– Start time 

– End time 

5. Specify how the process values are determined: 

– Sequence of process values 

– Calculation of process values 

Click "Properties" to configure the sequence and the calculation of process values. 

Detailed information on the configurable properties of a tag is available in the section 
'Editing a tag in Excel (Page 99)'.  

6. Click "Add" to enter the configured tag in the Excel worksheet. 

Result 
A tag is configured in the Excel worksheet. 

See also 
Configuring Properties of an Archive Tag (Page 93) 



 Information Server - Documentation 
 3.5 Reporting 

SIMATIC Information Server 
System Manual, 05/2017, A5E38560846-AB 99 

Editing a tag in Excel 

Requirement 
● You are connected to the Information Server. 

● A tag is inserted in the Excel worksheet. 

Procedure 
1. Click the "Tag > Edit tag" icon in the multifunction bar. 

2. Select the tag you want to edit. 

3. Select the settings in the "Properties" area of the "Layout" tab. 

4. Select the time settings for the tag in the "Configuration" tab. 

5. In the "Mode" area, select: 

– Time series: The tag values are displayed unchanged or interpolated in a time series. 

– Calculation: The tag values are displayed after the use of an aggregate function. 

6. To specify the properties of the modes, click "Settings…". 

7. Specify the mode of the time series: 

– Interpolation: Interpolated values per selected time interval. If, for example, the time 
interval is one minute and the time interval for the interpolation is 10 seconds, this 
results in 6 interpolated values, one value per 10 seconds. If you activate the 
interpolation, the additional selection of the time interval and the time unit is required. 
The input of the maximum number is possible. 

– Original data: Unchanged archived values with their timestamps. The "Internal" limit 
mode includes the values in the specified time interval. The "External" limit mode 
includes the last value before the time interval starts, and the next value after the end 
of the time interval. When you select the "Internal" limit mode, you can enter the 
maximum number. 

– Maximum number: Relevant for interpolation and the "Internal" limit mode. When the 
maximum number of values is set, the values from the start of the time interval up to 
the maximum number are output. If the maximum number is greater than the number 
of values that are present in the time interval, the "Max. number" setting is ignored. 
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8. Or specify the calculation mode: 

– Specify a time interval for which an aggregate is formed. 

– Specify the aggregate for the specified time interval: 
- Minimum: The minimum value 
- Maximum: The maximum value 
- Average: The average of all values 
- Sum: The sum of all values 
- Total: The integral of values 

– Specify a conversion factor to ensure the reference to the tag values. The following 
table shows sample values for the conversion factor. Additional factors can, for 
example, be a month or a year. 

 

Time unit Conversion factor 
Day 1 
Hour 24 
Minute 1440 
Second 86400 

The time unit is the second part of the unit/dimensions in which the tag values are 
measured, for example: Parts/day, tons/hour, meters/second.  

– The result of the "Total" calculation mode is the overall quantity in the specified time 
interval, for example, how many parts were produced in the last two hours or during a 
shift. 

9. Click "OK". 

10. Click "Apply" to accept the layout and the configuration of tags. 

Extended shortcut menu 
For tags, the "Copy/Paste" function is available in the shortcut menu. 

Do not confuse these functions with the standard function in Excel. 

In the "Edit element" window, you can also use additional functions by right-clicking a tag: 

● New 

● Delete 

● Change value mode 

● Change tag ... 

● Copy of ... 
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Value mode single value 
If you have selected the "Single value" value mode for the tag, select the time and the mode 
from the "Properties" area in the "Configuration" tab. 

The following modes are available for selection: 

● Exact: "Exact" mode shows the exact single value at the selected time. 

● Back: "Back" mode searches backward from the specified time to the first single value 
that appears. In WinCC projects, the function searches no more than 24 hours before the 
specified time. An empty line is output if no value is present in this time interval. 

● Next: "Next" mode searches forward from the specified time to the first single value that 
appears. In WinCC projects, the function searches no more than 24 hours after the 
specified time. An empty line is output if no value is present in this time interval. 

● Interpolated: "Interpolated" mode calculates the value from the previous and the following 
value at the selected time. If a value is present at the selected time, there is no need to 
select this mode. 

Result 
You have modified the parameters of a process value. 

See also 
Configuring a tag in Excel (Page 98) 

Configuring Properties of an Archive Tag (Page 93) 

Deleting a tag in Excel 

Requirement 
● A tag is available in the Excel worksheet. 

Procedure 
1. Click the "Tag > Edit tag" command in the multifunction bar. 

The "Edit tags" dialog opens. 

2. Select the tag you wish to delete in the list. 

You can only delete tags individually. 

3. Open the shortcut menu with a right-click and click "Delete". 

Result 
A tag has been deleted from the Excel worksheet. 
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Inserting message in Excel 

Requirement 
● You are connected to the Information Server. 

Procedure 
1. Click the "Message > Insert message" icon in the toolbar. 

The "Insert message" dialog opens. 

2. Select a project from which messages are to be output. 

3. Enter a name for the message block. 

You can specify the maximum number of messages that are to be entered in Excel. 

4. Select the "Layout" tab in the "Properties" area. 

5. Select the start cell for the messages. 

6. Specify the arrangement of the messages. 

The messages can be entered horizontally or vertically. 

7. Click the "Time range" tab. 

8. Enter the start and end time for the messages. 

9. Select the attributes for which you want to output messages. 

10. Click "Add" to insert the message into the Excel worksheet. 

Result 
A message is created in the Excel worksheet. 

 

 Note 

Position the mouse pointer on the input box for values to view a tooltip that informs you of 
the name of message block. 
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Editing a message in Excel 

Requirement 
● A message block is inserted in the Excel worksheet. 

● You are connected to the Information Server. 

Procedure 
1. Click the "Messages > Edit messages" icon in the multifunction bar. 

2. Select the message block whose settings you want to change. 

3. Select the relevant tab in the "Properties" area. 

4. Customize the name, layout, time range and the selection of attributes for the message. 

You can select several attributes in the "Attributes" tab. Enable the respective options. 

5. Click "Accept" to accept the changes. 

Extended shortcut menu 
For messages, the "Copy/Paste" function is available in the shortcut menu. 

Do not confuse these functions with the standard function in Excel. 

● Right-click of the mouse button > Information Server > Copy 

● Right-click of the mouse button > Information Server > Paste 

Result 
The changes to the message block are applied. 

Opening archive data in Excel 

Requirement 
● You are connected to the Information Server. 

● A tag or a message block is inserted in the Excel worksheet. 

Procedure 
1. Click the "Execute" icon in the multifunction bar. 

Result 
Data is retrieved from the Process Historian server or PCS 7 or WinCC OS for the 
configured tags and message blocks. 
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Saving a report 

Requirement 
● A report is configured in an Excel sheet. 

● You are connected to the Information Server. 

Procedure 
1. Click the "Store" icon in the multifunction bar. 

2. Select the area to which you want to save the report. 

You can save reports locally or online on the Information Server. 

3. Navigate to the relevant storage location. 

4. Click "Save". 

Result 
An Excel report is stored with the selected settings and the defined layout. 

3.5.3.7 Graphically evaluating process values 
You can graphically display process values in Excel. 

Requirement 
● A tag has been configured. 

● Process values are available in the Excel worksheet. 

Procedure 
1. Select the process values and the associated timestamps you want to evaluate 

graphically. 

2. Select the chart type you want to use in the Excel chart function. 

3. Place the chart at the required location in the Excel worksheet. 

If you have selected relative time specifications and click "Run", you update the process 
values displayed in the chart. 

Result 
The process values read are displayed graphically. 
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3.5.3.8 Providing templates 

Exporting Excel templates 

Introduction 
You can upload templates for Excel reports on an Information Server. 

You use the templates for Excel reports on the Information Server to create subscriptions. 

Requirement 
● An Excel template is open. 

● You are connected to the Information Server. 

Procedure 
1. Click "Save > On Information Server" in the multifunction bar. 

2. Select a target folder for saving the Excel template. 

3. Click "Upload". 

Result 
An Excel template is saved on the Information Server. 

Opening Excel templates 

Requirement 
● A template for an Excel report is saved locally on the PC or on the Information Server. 

● You are connected to the Information Server. 

Procedure 
1. Click the "Open" icon in the multifunction bar. 

2. Select the area from which you want to open the report. 

You may open reports from a local folder or online from the Information Server. 

3. Navigate to the desired report. 

4. Select the report and click "Open". 

Result 
A preconfigured Excel report is opened. 
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3.5.3.9 Using the alarm filter 

Introduction 
The message filter can be used to specify criteria for the attributes of the messages. The 
criteria limit the number of messages displayed. 

Requirement 
● You are connected to the Information Server. 

Procedure 
1. Click the "Messages > Edit message" icon in the multifunction bar. 

The "Edit message" dialog opens. 

2. Open the "Name" tab and click the "Filter" button. 

The "Message filter" dialog opens. 

3. Select an attribute as filter criterion in the "Attribute" column. 

4. Make your entries in the "Operator" and "Value" columns. 

Set conditions to restrict the attributes output. 

5. Click "OK" to accept the filter settings. 

6. Click "Accept" to accept the filter settings for the current message block. 

Result 
You have successfully specified the filter settings for a message. 
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3.6 Working with dashboards 
In the "Dashboard" portal, you can design your own pages for display in a Web environment 
and make them available to the users of the Web application. 

The Information Server provides preconfigured layouts and widgets for designing the pages.  

Layout of a dashboard 
A dashboard consists of one or more web parts that are filled with the widgets made 
available. The preconfigured templates define the number and position of the Web parts that 
are shown in the dashboard. 

The widgets contain a variety of information from projects and reports. You can use a widget 
as often as you want and configure it differently for each web part.  

The Information Server provides the following widgets for designing the pages: 

● Text editor: 

– For example, design a header and add an explanatory text. The following functions 
are available for formatting. 

– To include graphics or HTML pages, import the file to the Information Server or create 
a link to the file. 

– Create tables and add links. 

● Report template: 

– By integrating reports you can, for example, display process values and data from 
message archives for any time period. 

– If the dashboard page opens in the browser, the widget calls up the current values 
from the connected data source. The report is displayed as a static snapshot. To 
update the values, reload the dashboard page. 

– The widget does not provide access to reports or subscriptions that were created via 
the "Reporting" portal. 
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Requirements 
Users of the report widget must be members of the following groups: 

● SIMATIC Report Users 

● SIMATIC Report Publishers 

● SIMATIC Report Administrators 

Creating a dashboard 
1. To create a dashboard page, select a preconfigured layout with the required number of 

Web parts. 

2. To fill a Web part with content, drag a widget onto the Web part from the list on the left. A 
Web part can only contain one widget at a time. 

3. If you drag the "Report template" widget onto a Web part, the "Settings" dialog opens. 

4. Select a report template and set the desired report parameters. 

5. Enter a descriptive name for the dashboard page. 

6. Save the created dashboard page. The user of the Web application can now call up the 
page through the "Dashboard" portal. 

Managing templates and dashboards 
On the homepage of the "Dashboard" portal, you can see the existing dashboards and a 
preview using "Display". 

You can create and edit dashboards, as well as delete, import or export them. 

To import or export templates, click "Manage templates" in the top menu bar.  
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